# Table of Contents

Course Materials ............................................................................................................. 1
  - Course Workbook ........................................................................................................... 1
  - Hands-on Exercises Overview .................................................................................. 1
  - NetSuite Test Account .............................................................................................. 2
  - SuiteAnalytics Overview ........................................................................................... 2
  - SuiteDreams Company ............................................................................................. 2
01: Welcome ................................................................................................................... 3
  - Hands-on Exercise .......................................................................................................... 9
    - 01: Log in to NetSuite ............................................................................................. 9
02: Using Standard Reports ............................................................................................ 11
  - Hands-on Exercises ...................................................................................................... 17
    - 01: Identify Field Level Help in Report and Searches ................................................ 17
    - 02: Reports and Searches in SuiteAnswers ............................................................... 18
03: Customizing Standard Reports ................................................................................ 19
  - Hands-on Exercises ...................................................................................................... 28
    - 01: Identify a Standard Report ................................................................................... 28
    - 02: Identify Groupings on a Standard Report ............................................................. 29
    - 03: Modify a Standard Report – Add Columns and Group Data ................................ 30
    - 04: Set Up an Email and Create a Home Dashboard Snapshot .................................. 31
    - 05: Modify a Standard Report – Capture Count Data ................................................ 35
    - 06: Modify a Standard Report – Add Formula Fields to Calculate Values ................. 37
04: Creating New Reports ............................................................................................... 41
  - Hands-on Exercises ...................................................................................................... 46
    - 01: Create New Report .............................................................................................. 46
    - 02: Run a New Report ............................................................................................... 48
05: Setting Up Standard KPIs ....................................................................................... 49
  - Hands-on Exercises ...................................................................................................... 54
    - 01: Add a Standard KPI to the Home Dashboard ...................................................... 54
    - 02: Display KPI Data Graphically and Copy/Paste to Word ....................................... 55
    - 03: Add a KPI Meter to the Home Dashboard ........................................................... 56
06: Creating Saved Searches .......................................................................................... 57
   Hands-on Exercises .................................................................................................... 64
      01: Create a Saved Search for Inline Editing .......................................................... 64
      02: Create a Saved Search List for Marketing ....................................................... 66
      03: Create a Saved Search for Overdue Customers ............................................... 68
      03: Solution ............................................................................................................. 70
07: Publishing Saved Searches ...................................................................................... 71
   Hands-on Exercises .................................................................................................... 77
      01: Add Filters and Restrict Access to a Saved Search .......................................... 77
      02: Create a Saved Search for a Sublist View ....................................................... 78
      03: Create a Saved Search with an Email Alert .................................................... 80
      04: Add a Saved Search Email to an Existing Search .......................................... 83
      05: Create a Saved Search (Email Alert & Scheduled Email) ................................ 84
08: Adding In-Depth Analysis ...................................................................................... 87
   Hands-on Exercises .................................................................................................... 92
      01: Create a Saved Search with an Expression ....................................................... 92
      02: Create a Saved Search Using Summary Types ............................................... 93
      03: Create a Saved Search with Grand Totals ....................................................... 95
09: Applying Advanced Formatting and Calculations .................................................. 97
   Hands-on Exercises .................................................................................................. 101
      01: Create a Saved Search – Ordered More Than One Item ............................... 101
      02: Create a Saved Search – Spending Account Average ..................................... 103
      03: Sum Customer Balances by Territory ............................................................ 105
      04: Customer Overdue Balance Measure (Optional) ........................................... 106
10: Presenting Custom Metrics ................................................................................... 109
   Hands-on Exercises .................................................................................................. 115
      01: Define a Custom KPI ...................................................................................... 115
      02: Define a Custom Comparative KPI .................................................................. 116
11: Setting Up Trend Graphs and Scorecards ............................................................... 119
   Hands-on Exercises .................................................................................................. 126
01: Display a Custom KPI as a Trend Graph ........................................................... 126
02: Use Standard KPIs to Create a KPI Scorecard ............................................... 127
03: Compare Multiple KPIs in a KPI Scorecard .................................................... 128
12: Realizing Smart Dashboards ............................................................................. 131

Hands-on Exercises ............................................................................................... 137
01: Define Publish Permissions .............................................................................. 137
02: Design the Home Dashboard .......................................................................... 138
03: Design the Opportunities Dashboard .............................................................. 139
04: Publish the Dashboards ................................................................................... 140
13: Wrap Up ............................................................................................................ 143

Workbook Appendices ............................................................................................ 149
Requirements and Design Worksheets .................................................................... 149
Requirements and Design Worksheets .................................................................... 151
Course Materials

Course Workbook

The SuiteAnalytics: Reports and Searches course provides this workbook, which includes:

- Instructor delivered topics
- Exercises

Feel free to annotate in the workbooks:

- If using a printed copy, then write in the book
- If using a PDF document, you can add electronic “Sticky Notes”
  o Use the Adobe tools for commenting
  o Add the tool bar if necessary

Hands-on Exercises Overview

The course exercises simulate tasks that you may need to perform as part of your job responsibilities. Tasks include:

- Identifying and using reports
- Building and publishing searches
- Working with other SuiteAnalytics solutions

The exercises in the course are incremental, meaning the build upon one another. Therefore it is critical you complete all the required exercises and DO NOT skip them.

- For example, let’s say, you did not complete exercise ‘5’. When you try to complete exercise ‘10’, the exercise will fail, because there were elements in exercise ‘5’ were necessary to take in order to complete exercise ‘10’.

All solutions to the hands-on exercises can be found in the test account. In the global search box search for ZSASG.
NetSuite Test Account

As a student in this course, you are provisioned with a test account. Tasks are performed in the OneWorld type of NetSuite test account.

- This test account is available to you for the next thirty (30) days. It may or may not have the same functionality of your production account.
- Occasionally the presented material is different from the data that is in the test account during the class and that will be in the exercises.
- Working with a test account, you see “in person” and immediately how each decision you make builds to influence the next set of decisions to be made.

SuiteAnalytics Overview

SuiteAnalytics solutions are available in your NetSuite account:

- Powering real-time dashboards with reporting and analysis
- Working across the breadth of your account giving insight into ERP, CRM, and Ecommerce
- Enabling tailored visibility into the most current business metrics such as financial, sales, service, or marketing performance

SuiteDreams Company

SuiteDreams is a multi-subsidiary, global company. They sell various types of furnishing and service. SuiteDreams wants to take advantage of data analysis in NetSuite through the use of:

- Standard Reports
- New Reports
- Customized Reports
- Searches
- Saved Searches
- Key Performance Indicators (KPIs)
- Trend Graphs
- Data-rich dashboards
01: Welcome

Introduction
Welcome to SuiteAnalytics: Reports and Searches

About this Module
We look at the setup, flow and intent of this course:
- Instructor introduction
- Course intent and flow
- Identify course audience

Objectives
After completing this module you should be able to:
- State the intent of the course
- Describe the flow of the class
About this Course

You might be wondering:

What does this course deliver?
How will the course flow?
What new skills will I learn?

The instructor will be your guide to SuiteAnalytics using presentations and hands-on exercises focused on:

- Reports
- Saved Searches
- Key Performance Metrics (KPIs)

SuiteAnalytics

Provides fully integrated, real-time business intelligence:

- Leverage standard and custom reports for analysis
- Access information through saved searches
- Create intelligent, real-time Dashboards exposing key metrics

Helps you make informed business decisions by mining your data and providing analysis to help power your business.

Provides real-time operational, tactical and strategic intelligence in a single system
Reports

Provide point-in-time analysis:

- Tap standard reports for visibility into all areas of your business
- Add new fields, groupings, and formulas for custom analysis
- Configure ad-hoc reports to present specific metrics
- Present in easy-to-read, polished format

Saved Searches

Help you mine your data quickly:

- Expose data from across your business
- Define your query
- Design your display

Present lists of dynamic results to take action on:

- Set different views and access
- Update underlying records quickly
- Enforce Business Process Flows
- Focus users on critical information

Key Performance Indicators (KPIs)

Provide operational insight:

- Measure performance against objectives
- Identify trends
- Apply course correction in a timely fashion
- Leverage Key Performance Indicators (KPIs) and Scorecards

Real-Time Dashboards

Put business intelligence in front of all users:

- Create personalized and smart dashboards
- Get intelligence on all areas of your business
- Keep close to your business indicators
- Empower users to work intelligently and effectively
Course Audience

You are a NetSuite user with experience using NetSuite and possess basic knowledge of the features and concepts, but need to:

- Monitor the health of your business
- Gain visibility into trends and drive results
- Enforce business processes and Business Process Flows

Activity: Class Introductions

This is your chance to meet your classmates. Feel free to do some networking outside of class, by asking for and noting their contact information.

Course Goal

Upon completion of this course, you should be able:

- Effectively use reports, saved searches and KPIs
- Obtain real-time and actionable insight into your business
- Create “smart” dashboards to drive true operational insights

Course Objectives

This course answers these questions:

- How can I use standard reports for point-in-time analysis?
- Can I customize standard reports to match business requirements?
- Can I create searches to access and dynamically display key data?
- Are there standard metrics to help me monitor business trends?
- Is it possible to create a personalized, real-time dashboard rich with tools to analyze my operational performance?
Course Flow

This course steps through SuiteAnalytics solutions for data mining and analyzing your operational performance. Lecture, demonstrations, and exercises will go look at:

- Working with reports and standard Key Performance Indicators (KPIs)
- Creating saved searches and custom KPIs
- Analyzing operational performance

Course Agenda

Working with Reports and Standard KPIs:
- Use Standard Reports
- Customize Standard Reports
- Create New Reports
- Setup Standard KPIs

Creating Saved Searches and Custom KPIs:
- Create Saved Searches
- Publish Saved Searches
- Add In-Depth Analysis
- Apply Advanced Formatting and Calculations
- Present Custom Metrics

Analyzing Operational Performance
- Set Up Trend Graphs and Scorecards
- Realize Smart Dashboards

Conclusion
We remind you of all the objectives and topics presented in the course and provide you with resources for your future reference
Activity: What is Your Primary Objective?

You and your classmates share what is most important for you to get out of this class.

Now It’s Your Turn

Go to the following exercise (01) to log into the NetSuite training account:

- Enter the Login Email Address as provided by your instructor
- Enter Password credentials as provided by your instructor
- Please confirm with instructor once you are in the NetSuite account
Hands-on Exercise  
Suggested Time to Complete Exercises: 5 minutes

01: Log in to NetSuite

Scenario  
Let’s begin by giving you access to your demo account:

- Login to the application
- Answer three security questions so you can verify your identity if you forget your NetSuite password

Log In

1. Open your browser and type www.netsuite.com in the address field.
   Click the Customer login link. (You will only see this link if you are logging in for the first time.)

2. Enter the Email Address as provided by the instructor.

3. Enter the Password as provided by the instructor.

4. Check the Remember my email address check box and then click the Login button.

5. Set Up Security Questions: Please choose the following questions and use the answers as indicated in bold:
   What was your childhood nickname? Enter “nickname”
   In what city did you meet your spouse/significant other? Enter “city”
   What is your maternal grandmother’s maiden name? Enter “name”

6. Click Save and click Close in the Security Questions Complete pop-up window

7. Click through any additional pages to get to the NetSuite Application.

8. You should be on the Home tab.
02: Using Standard Reports

Introduction
We introduce the fundamentals NetSuite reporting.

About this Module
The NetSuite solution provides many pre-built reports that can help you gain insight into your business.

This module introduces the standard reports and provides guidelines for determining the source of their data and output:

- How can I maximize these to run my business?
- Where do I look to determine which reports work best for my company?
- Where do these reports get their data?

Objectives:
Upon completing this module, you should be able to:

- Determine the output of a standard report
- Investigate where report data comes from
- Associate parent/child relationships with field names
- Work with some of the nuances of the views
- Name and name (grouped)
- Views: source/field name
- Run reports, use output features and distribute reports
Using Standard Reports

When you need to...

- Summarize data into groups, totals and subtotals
  - For example: The Current Inventory Status report provides a snapshot of your current inventory data and can be useful in monitoring current inventory levels and determining ordering schedules
- View details of data within the report
  (to drill down into record details directly from report)

Be Aware...
That with a standard report you are not able to update data from within the report:

- You cannot change results displayed in the report on-the-fly, but you can drill-down to the actual record from the report and make changes

That by not using standard reports:

- You might spend time creating custom reports to collect data when the data is already available in standard reports

Best Practices

- Review your company’s existing reporting needs
- Peruse standard reports on the Reports Overview page
- Study NetSuite Help topics for Report definitions and content detail
- Refer to your Business Requirements Document (BRD)
- Execute a standard report to test content
  - Examine data and data sources
  - Run similar reports, compare the output (both summary and detail)

Reports Overview

Navigate to Reports > Reports Overview

- Click on the report grouping links to expand the available list of reports for that group
- The Reports Results portlet lists any scheduled reports and reports that use email alerts
- While you are on the Reports Overview page, click the Help link to view related Help topics for reporting in NetSuite
Execute a Standard Report

Execute a standard report and review the available information. You may need to help your warehouse manager review current inventory, so execute the appropriate report:

Navigate to Reports > Inventory > Current Inventory Status:
- Review the available information, columns and rows of information
- View the report construction by clicking on Customize
- The Report builder, 4-step wizard displays
  - Provides visibility and access to the report construction
  - Which fields are included as columns?
  - Where is the data being pulled from?
    - Look at columns and the grayed out fields
    - Access standard and custom fields for you different record types
    - Drill into subfolders as needed
  - Add Fields provides folders that represent views, composed of data objects

Drilling Down to View Detail

Many reports allow viewing summary or detail-level information. Let’s look at a purchasing report and drill into the information.

- Navigate to Reports > Purchases > Purchase by Vendor
  - Toggle between the View Summary and View Detail
- Use drill-down balloons to get to lowest level of detail
  - Depending upon the report, you can drill into one of the standard NetSuite record types of: entity, transaction, CRM, or item
  - In our example we can get all the way down to the Transaction Record.

Parent: Child Record Relationships

Parent: child records enable grouping and subtotaling in reports. For example SuiteDreams has parent / child hierarchy with their items

- Bedroom / Handcrafted Queen Bed
- Bedroom is the parent and facilitates subtotaling in a report, such as Sales by Item Summary
Using Parent: Child Relationships

Grouping
For grouping, think “toted by”

- Group With Previous Column allows data to be subtotaled by the data in the previous column
  - Example – this report list Location then the items sold at that location, then the next Location and the items sold there, and so on
- Subtotals are provided for each grouping level
- More than one grouping level is allowed, but don’t group too many fields or else the report will be unreadable

Name versus Name (Grouped)
If you are running a report on records that have a hierarchy, using name versus name (grouped) impacts the display. For example if we ran Sales by Sales Reps:

- Using Name would only display a list of the sales reps, without any grouping by manager
- Using Name (Grouped) displays the hierarchy, by manager

Full Name Limitations
Full Name includes the Parent: Child Relationship. For example execute a report based on inventory items and then choose Full Name - DINING ROOM: Urban Dining Table

- Does not enable grouping nor subtotaling

Subtotals
Use the appropriate tool in order to facilitate subtotals. Our example is again working with a sales report that uses Name (Grouped) to group and total sales by hierarchy, e.g. A Wolfe and subordinates
Activity: True or False

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Reports assist you in summarizing data into groups, totals, and subtotals.</td>
</tr>
<tr>
<td>2.</td>
<td>You can update the underlying data from the report.</td>
</tr>
<tr>
<td>3.</td>
<td>Starting with NetSuite Standard Reports is a waste of time.</td>
</tr>
<tr>
<td>4.</td>
<td>UsingName (Grouped) exposes any underlying hierarchy.</td>
</tr>
<tr>
<td>5.</td>
<td>Using the Full Name is the best way to get grouping and subtotaling.</td>
</tr>
</tbody>
</table>

Run and Distribute Reports

Run Reports
Some reports may take time to generate output, especially if they contain a lot of data

- Click the Alert me when ready link if the report is large
- Saved report results display in Reports > Report Results portlet, on the Reports Overview page

Report Output Features
Report Footer Options are tailored to the report’s definition and may be found at the bottom of the page:

- Filters: Date, Subsidiary Context, Column
- Tools: Options, Expand, Collapse, Find

Distribute Reports:
Reports may be shared from NetSuite

- Graph or print
- Email or schedule
- Export to another application
Activity: Match Game

Match the terms on the left to the task on the right

<table>
<thead>
<tr>
<th>Term</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph</td>
<td>Hover over, click, go to detail</td>
</tr>
<tr>
<td>Export</td>
<td>Slice and dice your report</td>
</tr>
<tr>
<td>Date filter</td>
<td>Provide report on recurring basis</td>
</tr>
<tr>
<td>Collapse</td>
<td>Display, copy, and paste into another application</td>
</tr>
<tr>
<td>Drill-down balloon</td>
<td>Select the point-in-time</td>
</tr>
<tr>
<td>Email</td>
<td>Send to Word, Excel, PDF or CSV</td>
</tr>
<tr>
<td>Schedule</td>
<td>Send to recipient</td>
</tr>
<tr>
<td>Column filter</td>
<td>Roll data up to highest level</td>
</tr>
</tbody>
</table>

Need More Information

NetSuite Help Center Topics:
- Reporting Overview and subtopics
- Working with Report Results

SuiteAnswers Training Videos:
- Peruse New Feature Training
- Search for answers to your reporting and training-related questions

Now It’s Your Turn

Complete the following exercises:
- 01 - Identify Field Level Help in Reports and Searches
- 02 - Reports and Searches in SuiteAnswers
01: Identify Field Level Help in Report and Searches

**Scenario**
In this exercise, you become familiar with NetSuite’s standard interface by locating elements that aid you when you need assistance.

**Review Reports Field Level Help**
1. Go to the Reports tab > New Reports.
2. In the Metric column, click Transactions hyperlink.
3. Under section 3, float the cursor over the word Component. A “What’s this?” tool-tip appears. This indicates Field-level Help. The majority of fields in NetSuite have ‘Field Help’ descriptions.
4. Click the Component field hyperlink to open Field Help and review the description.
5. Close Field Help when you are finished reviewing.

**Review Saved Search Field Level Help**
6. Go to the Reports > Saved Searches > All Saved Searches > New.
7. Select Customer from the list.
8. Click Available as Dashboard View Field Help and review the description.
9. Close Field Help when you have finished reviewing it.

**Note:** The purpose of this exercise is to make you aware of the ‘help’ options when you are working with reports and searches. These become very beneficial, when you are not quite sure of the purpose of a field.
영문 내역

02: Reports and Searches in SuiteAnswers

Scenario

In this exercise, you navigate through SuiteAnswers to help you locate additional resources when working with reports and searches.

SuiteAnswers is your one-stop shop for getting answers to your support and training-related questions. It is easily searchable knowledge center of rich support articles, best practices, help topics and training videos.

Review SuiteAnswers Options

1. Click the Support tab > Go to SuiteAnswers button. (A new window opens).

2. In the ‘Enter your search keywords...’ field enter Reports and Searches and click Search.

3. Review the left-hand column. Notice all results are categorized into Support Articles, Training Videos, Help Topics and Best Practices.

4. Click the Training Videos link.

5. Click the first video in the list to open the answer. Do Not play the video at this time.

   Note: The answer abstract describes the video duration audience and covered topics. When you click the play button, the video opens and plays in a new browser window.

Review SuiteAnswers Training Videos

6. From the top left-hand corner, click the Training Videos hyperlink.

7. Review the Training Videos list of topics (these are categorized by various roles and topics.) You may click through any of the listed topics.

8. Close the SuiteAnswers window and return to the NetSuite application.
03: Customizing Standard Reports

Introduction
My users need reports that are not available in NetSuite. How can I customize the standard reports to get the data they need?

About this Module
In this module, we examine how to:

- Use standard reports as base designs for custom reports
- Customize standard report definitions and content to meet the needs of your users
- Use best practices for customizing standard reports
- Extend report capabilities through filters, date ranges, Web Query and SuiteAnalytics Connect

Objectives:
Upon completing this module, you should be able to:

- Identify report requirements and plan the report design
- Use Report Builder to customize standard reports
- Apply best practices when creating custom reports
- Utilize filters, alternate date ranges, Web Query and SuiteAnalytics Connect feature to extend report capabilities
Customizing Standard Reports

When you need to:

- Present data in hierarchical groupings, totals and subtotals and the NetSuite standard report is not exactly what you need
  - For example: Add the Sales Rep name to the Sales by Sales Item report, to collect and display information by Sales Rep
- Access calculated fields or dimensions only available by report components and not available in Saved Searches
- Provide a more polished presentation output

By not using standard reports as the basis for a customized report you:

- Waste time constructing a new report from scratch to collect the data
- Do not take advantage of existing report content, layout of report or underlying functionality already defined
- You may lose your sanity!

Identify Requirements and Plan the Design

Reporting is a key analysis tool to measure performance against objectives

Understand your requirements, before customizing:

- What kind of data needs to be accessed?
- What is the business intelligence that must be extracted?
- Is there a need to share or distribute the data?
Identify Report Requirements

Start with a Standard Report
Can you really duplicate a spreadsheet with a NetSuite report?

We need a report to assist in re-evaluation customer credit limits. Are we losing business because customers have artificially low credit limits? Or, do customers have credit limits too large for their needs?

- With which standard report can I start?
- What is the total credit available to the customer base?
- Which customers need their credit limits reassessed?

Review underlying record and available fields
Review an entity record, which is the focus of the report, for financial fields:

- Credit Limit, Balance and Overdue Balance

Perform gap analysis
Compare the existing spreadsheet to a standard report output

- Review column and row data
- How do the report columns match up with the spreadsheet columns?
- How do the report rows match up with the spreadsheet report rows?
- What is missing and what is unnecessary?

Plan and Design the Report
In the appendix of this workbook, you have access to the Requirement and Design Worksheet

- You can also access the Requirements and Design Worksheet from the links in the shortcuts portlet on your Home Dashboard.
Activity: Match Game

Indicate if the statement is true or false.

1. Report Customization is easy, just jump right into it.

2. Keep using your spreadsheets, rather than a NetSuite Report

3. A gap analysis a good step to complete before starting customization

Using Report Builder

Edit Columns
Report folders contain record fields, both standard and custom

• Add fields (columns)
• Move or remove columns
• Label and format columns
• Add simple formula columns

Tips
• Save and preview as you go
• Develop a report naming convention

Filters
Add filters through the Add Fields pane

• Use filters to obtain the data that you want to view through the report
• Optionally – add filters to the footer to allow modifying the filter at run-time
• Use Show in Filter Region to allows users to modify the filters at run-time
Sorting
Add additional sorting options through the Add Fields pane

- Sorting options are applied in the order listed
- Use [Move Up] and [Move Down] buttons or drag and drop lines representing columns to determine the sort order

More Options
- Define Report Options, for instance:
  - Show on Reports Page
  - Allow Web Query
- You can customize Summary reports by allowing users to drill down to a specific custom Detail report of the same type:
  - Select a report from the Drill Down Report list
  - You can select only custom Detail reports to which you have access
- Define the audience and the access

Review new Custom report
This is the report from NetSuite that replaces the spreadsheet

- Report sorted by customer
- Key financial fields displayed as columns
- Simple formula provides necessary insight

Report Snapshots
Offer a quick look at important business results from your dashboard

- Standard or Custom Report may be placed on the dashboard
- Create Custom Snapshots from current standard reports
- ONLY Summary report can be saved as Snapshots (refer to Help for list)

Best Practices

- Review your company’s existing reporting needs
- Identify a comparable report
- Do a gap analysis
- Customize the standard report
- To see which report was used as the basis for a customized report, go to
  - Reports > Saved Reports > All Saved Reports.
  - The name for the standard report will be in the Report Type column.
Considerations: Report Performance

Reports can include up to 30 data columns
- Adding a 31st column results in an error on the Edit Columns page
- Attempting to run or re-save a report containing more than 30 columns will result in an error indicating that you need to reduce the number of columns in the report

Report Results can include more than 30 columns
- Add matrix columns during run time or add columns the through the Column filter

Only two different reports can be run at one time by a single user
- Attempting to run a third report triggers an error

Only one instance of the same report can be run at one time

Extending Report Capabilities

Use of filters to create a specific report
The transaction detail report is a very versatile report that can be customized to create a very specific report; for example- a report showing all customer deposits:
- Go to Reports > Financial > Transaction Detail
- Set the appropriate filters and view the refreshed results
- Click Customize when satisfied

It takes one change. Add the filter of Transaction Type equals Customer Deposit
- Go to Filters
- Open Transaction folder
- Select and define Transaction Type
- Click Done to add filter
- Preview the report to see the list of customer deposit, if any

Include Alternate Date Range columns
Use alternate date range (or alternate period range) columns to create comparative reports:
- Add/select multiple columns for the same measured field (e.g. amount or quantity)
- Define a date range type for each column:
  - Relative to report date: Defined in relation to the overall date range set for the report; changes when the overall report date range changes
  - Relative to today’s date: Defined in relation to the current date when the report is run; does not change when the overall report date range changes
Choose a date range

Our example is Purchases this year versus last year

- Go to Reports > Purchases > Purchases by Vendor Summary
- Click Customize
  - Remove total column
  - Add in 2nd Amount (Gross) for total column
  - Purchases this fiscal year v last fiscal year
  - Formula (Spending trend)
  - Percent Diff...(x-y)/x*100
  - X = This Year
  - Y = Next Year

**Working with Web Query**
Send report data via the internet allowing dynamic refresh of the data. Customize any report:

- Go to More Options, Report Options
- Enable Web Query
- Save the report
- View the saved report and export to Web Query

Email Web Query file to recipient(s)

- Recipient does not need to log into NetSuite to open the file
- The Web Query file may be saved to the recipient’s desktop

Recipient(s) opens file

- Requires NetSuite email login of person that sent the file
- Output opens in excel
- Data may be refreshed (Data > Refresh)
- *Note: any formatting added to the excel file is lost upon data refresh*

Use Web Query when you need to:

- Share NetSuite data outside of the NetSuite application
- Provide recipients with the most current information

Use Web Query only when necessary

- Monitor your distribution list
- Remove web query definition when no longer needed

Financial Statements are not supported by Web Query
Tips
- Suggest using a name convention, such as Report Name: WQ
- Makes Web Query-enabled reports easy to identify

SuiteAnalytics Connect Feature
SuiteAnalytics Connect is an Advanced Reporting feature to expose NetSuite data for ‘Open DataBase Connectivity’ (ODBC) access

- Requires download of NetSuite Driver; fee applies
- Enterprise views of your NetSuite data, including custom records
- Facilitates more advanced reporting, using external report writers
  - Microsoft Excel, Crystal Reports, or any other ODBC-compatible tool

SuiteAnalytics Connect Feature Set-Up Requirements:
- Advanced Analytics permission
- SuiteAnalytics Connect Feature has been provisioned for your account
- Download NetSuite’s Drivers

Activity: Match Game
Match the term on the left to the corresponding task on the right

<table>
<thead>
<tr>
<th>ODBC</th>
<th>Add, remove, move columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Column</td>
<td>Refine report results</td>
</tr>
<tr>
<td>Alternate Date</td>
<td>Define Report Options and Audience</td>
</tr>
<tr>
<td>More Options</td>
<td>Add column to display results of a calculation</td>
</tr>
<tr>
<td>Filters</td>
<td>Create a comparative report between two dates</td>
</tr>
<tr>
<td>Web Query</td>
<td>Facilitates advanced reporting with 3rd party tool</td>
</tr>
<tr>
<td>Add Formula Field</td>
<td>Enables refresh of report data outside of NetSuite</td>
</tr>
</tbody>
</table>
Need More Information

NetSuite Help Center Topics
• Report Customization
• SuiteAnalytics Connect

SuiteAnswers
• Search for answers to your reporting questions
• Go to Training Videos to access the Saved Searches/Reports category for these videos:
  • Reports: Relative Alternate Date Range Columns and Balance Forward Option
  • Reports: Custom Summary to Custom Detail Report Drill Downs
    o ODBC: Advanced Reports Overview
    o ODBC: Enterprise Views Using Open Database Connectivity

Now It’s Your Turn

Complete the following exercises:
• 01 - Identify a Standard Report
• 02 - Identify Groupings on a Standard Report
• 03 - Modify a Standard Report – Add Columns and Group Data
• 04 - Set Up an Email and Create a Home Page Snapshot
• 05 - Modify Standard Report – Capture Count Data
• 06 - Modify a Standard Report – Add Formula Fields to Calculate Values
Hands-on Exercises
Identify a Standard Reports
Suggested Time to Complete Exercises: 30-40 minutes

01: Identify a Standard Report

Scenario
In this exercise, you find a standard NetSuite report to satisfy specific requirements.

- The warehouse manager has asked you to provide him with a report to monitor the current inventory levels and help determine an ordering schedule.
- You use multiple locations so the report needs to provide data grouped by location.
- The report should include the preferred stock level and the reorder point.

Review Existing Documentation

1. Go to the Reports tab > Reports Overview
2. Go to the Help Center. Click the Help link (in the top right hand corner) to view Reporting Overview page
3. Scroll down and click the Standard Reports link
4. From the report descriptions, select the report that most closely matches your requirements
5. Close the Help page

Test Report

6. Navigate back to the Reports tab > Reports Overview
7. Click on the report that contains the information required to meet the warehouse manager’s request
8. Run the report
9. Does the report output meet the requirements? If so, What is the name of this report? If not, repeat steps 7 and 8.

Answer:
02: Identify Groupings on a Standard Report

Scenario
In this exercise, you find a pre-built NetSuite report and identify how the report content is grouped.

- The Sales Manager wants to know which category of items generates the most sales.
- They want to see a sales report in which the sales totals for items are grouped by category.
- They are not interested in seeing any detail.
- They would like a copy of the report in a PDF file.

Review Existing Documentation
1. Go to the Reports tab > Reports Overview
2. Click Help link to view the Reporting Overview page.
3. Scroll down and click the Standard Reports link
4. From the report descriptions, select the report that most closely matches your requirements
5. Close the Help page

Test Report
6. Navigate back to the Reports tab > Reports Overview
7. Click on the report that includes most of the criteria you need to see in your report
8. Run this report
   
   **Hint:** You may need to change your Date filter (e.g. Last Fiscal Year), Subsidiary filter, and any other relevant filters to see data
9. Does the report output meet the requirements? If so, what is the name of this report? If not, repeat steps 7 and 8.
   
   **Answer:**

10. Collapse the Report using the Collapse button until the report is reduced to just the Item types (Inventory Item, Non-Inventory Item, Service)
11. Now click the Expand button once to show the totals of items by their category.
12. List 3 categories that display under the Inventory Item type.
   
   **Answer:**

13. Export the Report to a PDF.
    Notice the report matches the exact look of the report when exported – i.e. the items are collapsed into the categories. This does not occur if you export to Excel or CSV.
03: Modify a Standard Report – Add Columns and Group Data

Scenario

In this exercise, you practice modifying a standard report.

- The Sales Manager needs to know who is selling what! Which products are being sold by which sales reps.
- The Sales by Item standard report has nearly all the information that the Sales Manager needs, the only information missing is the sales person’s name.
- Your job is to create a report definition, using the Sales by Item standard report as the base report.
- Use the Design Worksheet to help layout your report.
  - Think about what you need on the report output: Sales rep, product, quantity sold and the total revenue generated by the sale.
  - The Sales Manager also wants to be able to review the data for “the rolling half” with a column monthly total.

Select the Report

1. From Reports > Sales, select the Sales by Item report.
   The report displays on your screen. Review the report to become familiar with its contents.
   **Hint:** You may need to change your Date filter (e.g. Last Fiscal Year), Subsidiary filter, and any other relevant filters to see data.
2. Click the Customize button when you are ready to modify the report to meet the sales manager’s requirements.

Edit Report Columns

3. Add a Sales Rep column to the report. Group the Report by Sales rep, and then by Item Type.
   **Hint:** Use the Name field from the Sales folder, Primary Sales Rep subfolder.
4. Move the Primary Sales Rep column to the left so it becomes the first column.
5. Click and highlight the Item Type column. Click the Remove Column button.
6. Click and highlight the Item column. Check the Group With Previous Column box.

Options to Include

7. Click the More Options link above the report’s name. Place a check on the Show Currency Symbol box to display the Currency symbol for all amount fields displayed on the report.
8. Make the custom report available on the Reports page. Check the Show on Reports Page option.
9. Click the Edit Columns button.
10. Give the report a unique name, such as Sales by Item by Rep. Click Preview to preview the report.

11. Click the Return to Customization button to continue to work with the report definition, if necessary.

12. Click Save when you are satisfied with the results.

04: Set Up an Email and Create a Home Dashboard Snapshot

Scenario

In this exercise, you modify a standard report and then make it available to multiple people. The exercise includes steps to create a snapshot on the Home Dashboard

- The Customer Profitably report output is very close to the data that is required.
  - You must add the subsidiary field to group the customers and then modify the sort options to show the companies that generate the greatest profits within each subsidiary.

- The Board want to know which subsidiaries have the most profitable customers.
  - From which customer in each subsidiary does the company generate the most profit?
  - They have asked to have a report emailed to them weekly that shows the top companies for profitability.
  - Further, the CEO wants this information to display on his home dashboard as a snapshot.

Select the Report

1. From Reports > Customer/Receivables, select the Customer Profitability report.

   Change the Date filter to the This Fiscal Year and click Refresh. The report displays on your screen. Review the report to become familiar with its contents.

   **Hint:** You may need to change other filters to see data.

2. Click the Customize button when you are ready to modify the report to meet the Board’s requirements.

Edit Report Columns

3. Add the subsidiary field to the report definition.

   The subsidiary field is: Customer/Project: Subsidiary: Name (Grouped)

   Place this column in the first column and group the customers within each subsidiary.

   **Hint:** Use the ← Move button or drag and drop the Customer/Project: Subsidiary: Name column to the first column. Highlight the Customer: Job column and place a check on the Group With Previous Column box.
**Choose the Sort Order**

4. Sort the report on **Profitability: Profit** in **Descending** order.

   **Hint:** Click the Sorting step first; in the Add Fields column, expand the Profitability folder and click **Profit**. After you add the Profit field and check the Descending box, click **Add** to be sure this information is entered. To sort on this field primarily, highlight and drag the Profitability field to the top. Click **OK**.

5. Click the **Preview** button.

6. Click the **Return to Customization** button.

**Create a Snapshot of this Data**

7. Click **Edit Columns**, and then click the **Save and Create Snapshot** button.

   **Note:** You can only save Summary reports as Snapshots.

8. In the **Portlet** title, enter: **Top Customers’ Profitability**.

9. On the **List** tab, select the (click the checkbox) **Customer: Job** and **Total Profit** values to display in the **Narrow Portlet**.

10. Select all of the column values to display in the **Wide Portlet**.

**Create a Graph**

11. Click the **Graph** subtab.

12. For the X axis, select **Customer: Job**.

13. For the Y axis, select **Total Profit**.

14. Click **Save**.

**Send Report in Email to Board Members**

15. Click the Email icon  📧 (lower left-hand side) to review this screen.

Because we are working in demo accounts, emails are not sent, therefore it is not necessary to select recipients. However, from your production NetSuite account, you would select an email recipient from the Recipient dropdown list.

   **Note:** The report will be sent in the body of the email unless you check **Send Report as Attachment** on the Message subtab.

   **Note:** You may have to expand the size of the pop-up window to reveal the Attachment check box in the bottom left.

16. Click the **Cancel** button, and close the pop-up window.
Schedule When the Report Will Be Sent

17. Click the Schedule icon (lower right-hand side).
18. Select the day and time for the report to be sent.
   Enter the time of day that the report should run. If the time you select is during peak hours, this will be indicated to the right of the time field.

   ![Start Time: 2:00 pm](time_field)
   ![Start Time: 2:00 pm](time_field)
   **Peak Hours**

   **NOTE:** Peak hours are 6am to 5pm Pacific Time.
   Remember: On the Message tab, check **Send Report as Attachment** otherwise the report will be sent in the body of the email.

20. Select the **Run Report More Than Once** checkbox to set a recurrence pattern.
21. Click the **Cancel** button.

Save the Report

22. Click the **Customize** button.

23. Enter the report title **Top Customers’ Profitability** then click **Save** to save the report.

Add Report Snapshot to Home Page

24. Return to the **Home Page**. Select the **Personalize** link.

25. From the **Personalize Dashboard** panel, click on, or drag and drop a **Report Snapshots** icon to the **Home Page**.

27. Place the portlet in the wide column of the Home Dashboard. Change the layout to a **graph**. **To do this**, click on **Set Up** inside the portlet (click the downward arrow next to the three horizontal bars in the upper right corner of the portlet), choose the **Snapshot** name (**Top Customers’ Profitability**) in the drop down list. Set the **Display Type** to **Graph**. You can set other report options such as the Chart Theme. Click **Save** when finished.

28. Also in the **Set Up** menu are the options for printing and downloading the image.
05: Modify a Standard Report – Capture Count Data

**Scenario**
In this exercise, the requirement is to add numeric information to the **Sales by Customer standard report**, to count the number of individual orders and sum the currency amounts. The goal is to have an accurate count of the number of completed sales.

- The sales manager wants a monthly report that shows a count of transaction types.
- To assist with their analysis, they also want to sort the report by the customers with the highest total sales by type (invoice or cash sale).
- To avoid producing a misleading report, journals – used to enter opening balances - need to be excluded from the report.

**Select the Report**

1. From the **Reports > Sales**, select the **Sales by Customer**.
2. The report displays on the screen. Review the report to become familiar with its contents.

   **Hint:** You may need to change your Date filter, Subsidiary filter, and any other relevant filters to see data.
3. Click the **Customize** button when you are ready to modify the report to meet the new requirements.

   **Reminder:** Save the report with a new name.

**Edit Report Columns**

4. Add the following columns to the existing report columns:
   - **Transaction Type : Long Name** (Go to the Sales folder then Transaction Type subfolder – Note: choose the first folder, ignore the duplicate folder if shown)
   - **Transaction Total (Revenue)** – (Go to the Sales folder and find then click on Transaction Total (Revenue); the field title may automatically change to display as Sales. This is a duplicate field but is required to allow for a true count of our transactions.)

5. Click the **Sales** column that you have just added (Note, the field may be named Transaction Total (Revenue)).
   Select the **Summary** dropdown and select the **Count** option. Change the label of this column to **Number of Sales**. Click [Tab] after changing the label to see your change. Make sure this is the last column displayed.

6. Select the **Transaction Type: Long Name** column– Move this to the first column in the report, and choose to **Group** the report by this field. Change the label of this column to: **Type of Transaction**. Click [Tab] after changing the label to see your change. No other grouping is needed.
Select the Filters
7. Let’s apply a filter to the report so that Journals are excluded. We will enable this filter in the footer so that this can be changed at run time if required. Click on the Filters link.

8. Add Transaction Type: Long Name (Go to the Sales folder then Transaction Type subfolder – Note: choose the first folder, ignore the duplicate folder if shown) in the small pop up, change the Filter from the default equal to not equal to and type in Journal and hit [Tab] (or use the button to select Journal from the list of available transaction types.)

Check Show in Filter Region check box to display this filter at run time.

Select the Sort
9. Let’s sort the report to display the customers with the highest total transaction value at the top. Click on the Sorting link.

10. Add the Sales: Transaction Total (Revenue) field to the sort, choose to show results in descending order. Be sure to move this field to the top – this should be the first field for sorting. Click Add.

Add More Options
11. Click on More Options. Navigate to the Expand Level dropdown – select to display this report as fully collapsed (Collapse All) when the report is run. Click Edit Columns. Click Preview.

Preview the Report
12. When you expand the report, your results should be grouped by transaction type, and then sorted by the highest total sales per customer for that month.

13. If the report looks good, click the Return to Customization button. Save the report with a unique name.

If the report output does not look right, click the Return to Customization button to continue to work with the report definition.

Save this Report
14. Once the report is correct, save it. In the Name field, give the report a title, such as Sales Revenue by Transaction Type. Don’t forget to save!

Give Users Access to this Report
15. Click the Return to Customization. To complete the exercise, under the More Options sub tab, give the Sales Manager (in all subsidiaries) access to this report.

Don’t forget to Save! (Ignore the Overwrite message you may receive)
06: Modify a Standard Report – Add Formula Fields to Calculate Values

**Scenario**
In this exercise, you practice modifying a standard, sales report.

- The Sales Manager wants a summary report that compares his sales reps total sales this month with what they sold last month.
- They need to know the actual amount difference in the total sales this month as compared to last month.
- They are also looking for the percentage difference that number represents.

This scenario is similar to a KPI, however, it’s printable, and shows all sales reps and their sales differences this month compared to last month. Also, it’s displaying sales reps by their hierarchy for reporting.

- To show all sales people show at a single level on the report, with no hierarchical structure, make sure the field chosen in Step 1 is **Sales Rep Name**, instead of Sales Rep Name (Grouped).

**Select the Report**

1. From **Reports > Sales**, select the **Sales by Sales Rep** report.

   Change your Date filter to **this month**. The report displays on your screen. Review the report to become familiar with its contents. Change the **Column** field to: **Total**, and **Refresh** the data. The Total view of this report is what we are basing our customizations on.

2. Click the **Customize** button to modify the report to meet the sales manager’s requirements.

**Edit Report Columns**

3. Give the report a unique title: **Sales by Sales Rep Monthly Comparison Report**

4. Add the following columns to the report definition:
   - **Sales: Transaction Total (Revenue)** - Yes, this is a duplicate field!

5. Edit the following columns in the report builder:
   - **Sales (Transaction Total)** – the existing report column – From the dropdown, choose an alternate date range type of **Relative to report date**. Select an alternate date range of **this month**, and re-name the column: **Sales This Month**.
   - **Transaction Total (Revenue)** – the newly added column may also be referred to as Sales or Transaction Total – From the dropdown, choose an alternate date range type **Relative to report date** Select an alternate date range of last month, and re-name the column: **Sales Last Month**.

6. Add two **Formula** fields to the report columns by clicking twice on the Add Formula Field button (in the left of the screen just above where the fields are selected).
7. Enter the following values for the **First Formula** field:
   - Column label = **Difference: This Month vs. Last Month**
   - Formula Type = **Difference** \( x - y \)
   - \( X = \text{Sales This Month} \)
   - \( Y = \text{Sales Last Month} \)

   Check the box for **Apply Formula to Grand Total**, and check the **Add Grand Total** box.

Enter the following values for the **Second Formula** field:
   - Column label = **% Difference This Month vs. Last Month**
   - Formula = **Percent Difference of X** \( \frac{(x-y)}{x} \times 100 \)
   - \( X = \text{Sales This Month} \)
   - \( Y = \text{Sales Last Month} \)

   Check the box for **Apply Formula to Grand Total**, and check the **Add Grand Total** box.

8. **Save** the report to preview the results.

9. Select **Total** from the **Column** dropdown list. For this report only – it is important to change the **Column** dropdown menu to **Total** and to click **Refresh** to get the report data we are expecting. If you leave the column dropdown as Month, the report will not display the correct information.

10. Click the **Return to Customization** button, and, if the report looks correct, skip to Step 12 to complete the report.

11. If the report output does not look right, click the **Return to Customization** button to continue to work with the report definition.

**Provide Report for the Sales Manager**

12. To complete the exercise, under the **More Options** subtab, select the appropriate **sales managers** who should have access to this report, and choose to **Show Zeros** within the report. Click **Edit Columns**.

   Save your report. Overwrite your existing report if prompted to do so.
Solution 01: Identify a Standard Report

9. Does the report output meet the requirements? If so, what is the name of this report? If not, repeat steps 4 and 5.
   
   **Answer:**
   
   *Current Inventory Status Report within the Inventory/Items*

Solution 02: Identify Groupings on a Standard Report

9. Does the report output meet the requirements? If so, what is the name of this report? If not, repeat steps 3 and 4.
    
   **Answer:**
   
   *Sales by Item Summary Report.*

12. List 3 categories that display under the Inventory Type Item.
   
   **Potential Answers:**
   
   - Carpet/Floor Coverings
   - Dining Room
   - Living Room
   - Office Furniture
04: Creating New Reports

Introduction

I need to present data in a matrix format. None of the standard reports allows this, even with customization. What can I do?

About this Module

This module presents guidelines for using the New Report feature to create reports in the following formats:

- Summary
- Detail
- Matrix

Objectives:

Upon completing this module, you should be able to create a new report by following these steps:

- Identify the data
- Select the metric
- Format the report
- Subtotal the report
- Summarize a matrix report
Creating a New Report

When you need to:

- Create a matrix report
- Collect report information that does not exist in any standard report
  - For example: Purchasing needs a report showing purchases by item and by accounting period.

To create a new report:

- You need to know where to find the data you want in the report
  - For example: For a sales report, determine if the information required is stored with sales or with customer objects

**Purchasing Report Example**

There is not a standard report that shows purchases by Item by Accounting Period; the standard purchasing reports do not meet the requirements.

A New Report needs to be created:

- Utilize the Requirements Worksheet as part of the planning
- Complete the Design Worksheet
Create New Report

Identify the Data
Navigate to Reports > New Report

- Select the data on which to report
  - For our example: Purchases
- In the Report Title, name the report

Select the Metric
Select the available metric within this data set

- For our example: Amount (Gross)

Format the Report
Select the format of the report:

- Summary
- Detail
- Matrix

Subtotal the Report
Select how you want to subtotal the report

- Component determines the rows
- Field pulls in key data for that row
  - For our example: Item and Name (Grouped)

Summarize the Matrix Report
If your report format is Matrix, then select how you want to summarize the data across columns:

- Divide the report into multiple columns based on the column value selected
  - For our example: Accounting Period
- Creates the matrix format

Run the Report
Click Run Report to see the output

New Report Matrix Output
Does the report output match the report design?
Managed Saved Reports (Administrators)

Saved Reports are search-based

- Navigate to Reports > Reports Overview > All Saved reports and turn on Inline editing
- View all private/shared reports (filter by Owner)
- Use Direct List Edit to mass-edit reports
- Delete single | (multiple reports, or change Owner via Mass Update)

Reports Audit Trail

In the Report Builder – More Options – access the audit trail

- Includes all report property changes

Best Practices

- Design, design, design: design the report before starting to construct it
- Determine the required fields for the report
- Look at records and transactions in NetSuite to familiarize yourself with where data “lives”
- Consider user roles and permissions before you share your report: remember the same report run by two users with different roles may result in different results

Activity: Identify the Correct Order

Order the following steps, and then see how you did.
Need More Information

NetSuite Help Center Topics
- Ad Hoc Reports
- Report Customization

SuiteAnswers
- Search for answers to your reporting questions
- Go to Training Videos to access the Saved Searches/Reports category for the following training videos:
  - Reports: Custom Summary to Custom Detail Report Drill Downs
  - Reports: Customizing Report Footer Filters
  - Reports Using Per-report Permissions
  - Review any ‘Saved Search’ videos at your discretion

Now It’s Your Turn

For hands-on practice, you will:
- 01 - Create a New Report as a Summary, Detail and Matrix Report
- 02 - Run a New Report
### Hands-on Exercises
Create New Reports
Suggested Time to Complete Exercises: 10-15 minutes

<table>
<thead>
<tr>
<th>01: Create New Report</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scenario</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

#### Part 1: Run a New Summary Report

**Select the Data Set for a Summary Report**

1. Go to **Reports > New Report** and select the **Customer Count** data set.

**Set New Report Parameters**

This brings you to the screen where you enter the report parameters.

2. Enter the following information:
   - Report Title: **Customer Count By Rep Summary**
   - Metric: **Total**
   - Format for this report: Click **Summary**
   - Component: **Sales Rep**
   - Field: **Sales Rep**

3. Click the **Run Report** button.

4. Change **Subsidiary Context** to **US – West**; filter the **Date** to **this fiscal year** and click **Refresh**.
Part 2: Run a New Detail Report

Select the Data Set for a Detail Report
1. Go to Reports > New Report and select the Customer Count data set

Set New Report Parameters
   This brings you to the screen where you enter the report parameters.
2. Enter the following information:
   - Report Title: Customer Count By Rep Detail
   - Metric: Total
   - Format for this report: Click Detail
   - Component: Sales Rep
   - Field: Sales Rep

3. Click the Run Report button.
4. Change Subsidiary Context to US – West; filter the Date to this fiscal year and click Refresh.

Part 3: Run a New Matrix Report

Select the Data Set for a Matrix Report

Set New Report Parameters
   This brings you to the screen where you enter the report parameters.
2. Enter the following information:
   - Report Title: Customer Count By Rep by Month
   - Metric: Total
   - Format for this report: Click Matrix
   - Component: Sales Rep
   - Field: Sales Rep
   - Column: Month

3. Click the Save button.
4. Change Subsidiary Context to US – West; filter the Date to this fiscal year and click Refresh.
02: Run a New Report

Scenario

The CEO needs forecasting data from the sales manager to help determine if the company’s revenue projections are on track for the fiscal year.

In this exercise:
- You run a new report for the sales manager to look at forecasting information.
- The report needs to include the **Projected Amount** for each sales rep by **Month** as well as the total forecasted amount for all the sales reps.

**Suggestion:** Use the Design Worksheet to draft the report’s final output.

Select the Data Set

1. Go to Reports > New Report and select the **Forecast** metric.

Set New Report Parameters

This brings you to the screen where you enter the report parameters.

2. Enter the following information:
   - Report Title: **CEO Revenue Forecast Report**
   - Metric: **Projected Amount**
   - Format for this report: Click **Matrix**
   - Component: **Sales Rep**
   - Field: **Sales Rep**
   - Column: **Month**

3. Click the **Save** button.

4. Change **Subsidiary Context** to **US – West**; filter the **Date** to **this fiscal year** and click **Refresh**.

**Note:** This report might take a little time to run.
05: Setting Up Standard KPIs

Introduction
How do you monitor key business drivers and how quickly can you spot changes in your business?

About this Module
Do you spend hours running reports and drilling for data?

- Do you need the information “right now”?
- Do you need a real-time display, each time you access NetSuite?

Using Key Performance Indicators (KPIs) facilitates:

- Tracking specific metrics
- Spotting changes in your business drivers, as they happen

Objectives:
Upon completing this module, you should be able to:

- Add the KPI portlet to the Home Dashboard
- Setup standard KPIs
- Display a KPI as a popup trend graph
- Setup a KPI meter
- Share a KPI trend graph with another application
What is a Key Performance Indicator?

A KPI is a measurement or count of one of your business metrics:

- Shows key variances and over-time trends
- Helps identify trends so you can make course corrections in a timely fashion

NetSuite provides over 75 pre-packaged KPIs based on NetSuite standard reports:

- Synthesizes your raw data into critical business metrics in the formats you choose
- Allows you to spend more time learning from and acting on important data, and less time gathering it

Use KPIs When You Need To…

Track information to spot trends in your business, for example:

- A KPI on the Bank Balance with a Threshold set will let you know if the Company Bank Balance falls below $20,000
- A KPI on Sales will let you know if Sales are trending up or down, and by how many percentage points
- A KPI on Web Page hits will allow you to see if more or fewer people are visiting your website

KPIs are role-based and feature-based:
KPIs you choose depend upon the Role used to log in to NetSuite and features enabled in your NetSuite account

Setting Up KPI Portlet and Meters

Add metrics to the Home dashboard
Click the **Personalize Dashboard** link on the Home Dashboard to open the **Add Content** panel and select the following portlets:

- KPI Meter - up to 3
- Key Performance Indicators
- Quick Date Selector

Set up the KPI portlet
Click **Setup**, in the KPI portlet, on the Home Dashboard

- Click **Add Standard KPIs**
- Choose the KPIs in the pop-up window and then click **Done**
Configure the Selected KPIs
Configure your KPIs and save your changes:

- Move KPIs up or down, for preferred display order
- Set the date Range and Compare Range, if needed
- Choose Employees to display data for
- Turn on or turn off comparisons
- Setup Highlight and Thresholds functionality

Configure the KPI headlines (optional)
Extra prominence can be given to KPIs using the Headline feature

- Don’t have too many headlines as this dilutes the impact

Configure KPI popup trend graphs
Select the Popup Trend Graphs subtab and configure the Data Text section:

- Default Chart Type: select which chart displays by default
- Default Time Increment: select the default time increment for data in all popup trend graphs
- Period to Calculate Moving Average: number of data points to use in calculating the slope of the moving average line in popup trend graphs
- Show Moving Average: Smoothens irregular data to expose underlying trends
- Show Last Data Point: If left unchecked, excludes the last data point in popup trend graphs:
  - If left checked the latest data might not be complete: e.g. one week into a new month shows only one week’s data compared to the previous complete month
    - Leave unchecked to exclude data for incomplete periods; eliminate a sudden, misleading drop in trend graph data
- Include Zero on Y-Axis: Starts graph plotting at zero
  - If checked, includes zero as the starting point in popup trend
  - By default, option is disabled to avoid showing misleading dramatic increases in initial trend graph data
  - Best Practice: Enable this option if the time period data represented in the KPI truly starts at zero
- Save your setting, the KPIS will now display

Now configure the Visual Builder section:

- Chart Themes: select a theme that configures the look and colors of shapes representing popup trend graph data
- Chart Background: You can set the background to display behind popup trend graph data here
- Custom Series Color: select a color or enter the hexadecimal value for the color you want to use for the trend graph line
Set up KPI meter
Click **View**, in the KPI Meter portlet, and select the KPI that you want to display as a meter

- Note: The KPI must first be displayed in the KPI portlet
- KPI Meters are graphical representations of your KPIs
- Up to 3 KPI meters can be displayed on the Home Dashboard

Working with KPIs

Display KPIs:
If your KPI is set as to compare one date range against the other, the change is calculated for you

- NetSuite indicates positive changes in green, and warns you of negative changes in red
  - For example, a decrease in payables is shown in green, but a decrease in your Sales is shown in red
- Drill down on each KPI data field to display the underlying report or data

Refresh KPIs
Get the latest data from your KPIs by either:

- Refreshing individual KPIs, or
- Refreshing the entire KPI portlet

Display and Use Pop-Up Trend Graphs
Click the Graph icon next to one of the KPIs

The popup trend graph displays:

- Change view by selecting the desired date range at the top
- Download image to use in other applications
- Export to a .csv file

Use Quick Selector
Choose settings to calibrate all dashboard analytics, such as KPIs and meters, to the same comparisons

Configuring Best Practices

- The KPI portlet should be placed at the top of the center column of the Home Dashboard
- Place KPIs in a logical order
- When using comparisons, the date ranges you set should complement each other
- Use Quick Date Selector to “change the window” on your KPIs, Meters, and Report Snapshots simultaneously
### Activity: Match Game

Match the terms on the left to the task/description on the right

<table>
<thead>
<tr>
<th>Quick Date Selector</th>
<th>Highlight KPI data that falls above or below threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup</td>
<td>Positive Change</td>
</tr>
<tr>
<td>Standard Report</td>
<td>Drill into underlying report</td>
</tr>
<tr>
<td>Threshold</td>
<td>Send to .csv file</td>
</tr>
<tr>
<td>Click on period</td>
<td>Change date range for dashboard elements</td>
</tr>
<tr>
<td>Change is green</td>
<td>Configure the KPI Portlet</td>
</tr>
<tr>
<td>Export</td>
<td>Basis of a Standard KPI</td>
</tr>
</tbody>
</table>

### Need More Information

**NetSuite Help Center Topics**
- Key Performance Indicators Overview

**SuiteAnswers**
- Search for answers to your reporting and training-related questions
- Go to Training Videos to access the complete self-paced training library
  - In the Saved Searches/Reports category:
    - Key Performance Indicators: Putting Trend Graphs on Multiple Dashboards

### Now It’s Your Turn

For hands-on practice, you will:
- 01 - Add a standard KPI to the Home Dashboard
- 02 - Display KPI data graphically and copy/paste to Word
- 03 - Add a KPI Meter to the Home Dashboard
Hands-on Exercises
Set Up Standard KPIs
Suggested Time to Complete Exercises: 5-10 minutes

01: Add a Standard KPI to the Home Dashboard

<table>
<thead>
<tr>
<th>Scenario</th>
<th>In this exercise, you add a standard NetSuite Key Performance Indicator portlet to the Home Dashboard.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Sales managers at SuiteDreams are paid bonuses based on the number of new customers acquired each year.</td>
</tr>
<tr>
<td></td>
<td>• Therefore they want to regularly compare new customer growth from year to year.</td>
</tr>
<tr>
<td></td>
<td>• To help the sales managers, you add the standard New Customers KPI portlet to their Home Dashboard.</td>
</tr>
</tbody>
</table>

Add the KPI Portlet to the Home Dashboard

1. Click the Personalize link in the top right-hand corner of the Home page.
2. Ensure the Key Performance Indicators portlet is selected in the Standard Content pane. You can also drag and drop the KPI Meter from the content pane to another location on your home page.
3. Close the Personalize pane by clicking on the Personalize link.

Select the New Customers KPI

4. Click the Set Up Link in the Key Performance Indicators portlet.
5. Click the Add Standard KPIs button.

   Note: Users with Google Chrome may experience ‘delay’ issues when clicking “Add Standard KPI”. Contact trainer if you have problems.
6. Select the New Customers KPI from the list of available standard KPIs. It will display in the pane on the right. Click Done.

Set the Highlighting and Headline Properties

7. Select Greater Than from the options in the Highlight If... Enter 10 in the Threshold
8. Check Headline
Set the Comparison Ranges

9. Select Previous One Year from the Range dropdown list.

10. Check the Compare column and set the Compare Range to This Year.

11. Click Save when you are done.

Note: if the Headline does not display, return to the Comparison Ranges and change the settings until a headline displays. Normally, you must meet the threshold setting to display the headline.

02: Display KPI Data Graphically and Copy/Paste to Word

Scenario

In this exercise, you display a standard NetSuite KPI as a graph, and then paste it in a Word document.

- The sales managers at SuiteDreams need to provide reports, showing the number of customers recruited each month, to the executive team as well as the board of directors.
- Rather than display raw data, the sales managers want to display this data as a graph.
- To do this, they make the New Customer KPI display as a graph, and then copy/paste the graph to a Word document.

Display a KPI Data as a Graph

1. Click the View Graph icon for the New Customers KPI. It is situated between the Indicator and Period columns.

   NOTE: As of this printing, graph is visible if using Chrome as the browser.

2. Select Monthly as the range in the popup graph.

3. Click 📈 and select the image format to download. (The image downloads to your computer’s Downloads folder).

   If using Chrome as your browser, then click the down arrow button to download the image and open the image to copy it.

Paste the Graph into Word

4. Open a new MS Word document.

5. Locate the image file in your computer (usually the Downloads folder).

   Perform standard Copy/Paste functionality into the Word document.
### Scenario

In this exercise, you add a NetSuite KPI Meter to the Home Dashboard.

- To help the sales managers monitor team performance, they need to see sales figures visually.
- To help them, you add a KPI Meter to their Home Dashboard.

1. Click the **Personalize** link in the top right-hand corner of the **Home** page.
2. Ensure that one of the **KPI Meters** portlets is selected.
3. Close the **Standard Content** pane.
4. Verify that **New Customers** is selected from the **View** dropdown list.
5. Click the **Set Up** link in the **KPI Meters** portlet.
6. Select **previous one year** from the **Range** dropdown list.
7. Select **this year** from the **Compare Range** dropdown list.
8. Click **Save**.
9. If you like, go back in and play with other ranges and compare ranges.
06: Creating Saved Searches

Introduction
Saved searches can highlight critical data and facilitate Business Process Flows:

- Allowing new lead records to be updated quickly
- Identifying specific groups of customers to be targeted for campaigns
- Identifying customers who have overdue payments

About this Module
In this module, we examine how to:

- Define saved search criteria and results
- Use highlighting and filters to make information obvious and manageable
- Export, email and add saved searches to Home Dashboards to share information and make it more accessible

Objectives:
Upon completing this module, you should be able to:

- Define saved search criteria and results
- Add images, color and other formatting options to results
- Add filtering options
- Export and email saved search results
Why A Saved Search?

When you need to:

- Create a dynamic list of results
- Incorporate criteria-based row highlighting to alert users to specific data
- Use complex formulas to obtain specific results from your data
- Expose saved search results in lists
- Create a custom KPIs
- Build KPI Scorecard components

Constructing a Saved Search

Start a saved search
Start from multiple ways:

- Reports > Saved Searches > All Saved Searches > New
- Lists > Search > Saved Searches > New
- Transactions > Management > Search Transactions > Saved Searches > New
- Homepage Create New toolbar > Saved Search icon

Select the record-based search type:

- Both standard and custom record types are available
- Available types depend upon your role’s permissions

Tips

- If your search involves any transaction data, start with a transaction type of search
- It is easier to add entity-based fields to a transaction search, than to add transaction-based fields to an entity search.

Add key information:

- Enter a meaningful **Search Title**
- Enter an ID to identify creation date or pull into a script
- Select Access Choices options
- Click the subtabs to go to the different search components

Tips

- Prefix your saves search titles with your initials. This will make finding them later much easier.
Define the criteria
Go to the Criteria and Standard subtab:

- Select fields from the standard Filter the drop-down list
  - Includes standard and custom fields
- Define field values from the pop-up window

Choose the results
Go to the Results subtab and define options at the top of the subtab:

- Specify up to three sorting options
- Select Output Type from the drop-down list
- Check, or not, the Run Unrestricted box
  - Only the Administrator can check the Run Unrestricted box
- Define Max Results field for number of records to display
- Check, or not, the Disallow Drill Down box

On the Columns sublist, select the fields for the column display:
- Add columns by choosing fields, as needed, from drop-down list
- Include your criteria in your results
  - To include line numbers in transaction search results, add the Line Sequence Number field

Tips
- You can use the Add Multiple button to select several fields from a multi-select, pop-up window. It’s faster!

Continue working with Columns:
- Remove columns that you do not want displayed
- Reorder columns
- Re-label column headings, if required, using Custom Labels

Save and view
Click Save & Run to save and view the results: (Note: Clicking save navigates you away from your saved search, but does not display the results)

- Save often so you do not accidentally lose your work
  - Saving the search saves the search criteria

View the results and then return to search to edit:
- Each time the search is run, results are refreshed
- Click Edit this Search
- You can continue to edit and modify the search
Tips

• Change how single record results display by going to Home > Set Preferences > Reporting Search and selecting Show List When Only One Result.
• This can also be set as a company-wide setting by the administrator

Activity: True or False

```
<table>
<thead>
<tr>
<th></th>
<th>Indicate if the statement is true or false.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>You can only create searches for standard records.</td>
</tr>
<tr>
<td>2</td>
<td>Customer searches are always the best.</td>
</tr>
<tr>
<td>3</td>
<td>Criteria is defined by selecting from a list of standard NetSuite fields.</td>
</tr>
<tr>
<td>4</td>
<td>Including criteria in your results is usually a best practice.</td>
</tr>
<tr>
<td>5</td>
<td>Save and Run saves the criteria and displays the results.</td>
</tr>
</tbody>
</table>
```

Refining a Saved Search

Use mainline in transaction searches
By default transaction saved searches default to Main Line Either

You can change this behavior:

• Select Main Line from the standard Filter the drop-down list
• Define field values from the pop-up window
  o Select Yes to return transaction header information
  o Select No to return line-level information
  o Click Set to register your choice

Include joins
Include joined fields, in search results, to display more details

• Joined fields are usually found on record sublists
  o Scroll down to joined fields, indicated by ellipses
• When adding joins, use Add Multiple to select more than one field
  o Select the fields in the pop-up window and click Add
Highlight critical information
Select your formatting on the Highlighting and Highlighting if… subtab:

- Select the Highlight if Condition fields from Set Filters icon
  - The condition must be one of the criteria fields in the search
- Select the Filter fields from the drop-down list
- Define the values and click Set, and then Set the filter
- Continue selecting fields as needed

Define the formatting for each condition
- Each condition has its own formatting
- Conditions are highlighted in the order listed
  - Conditions may be re-ordered using the buttons
- Highlighting applies an if/then statement to the condition
  - For example: If amount is less than $50000, then text is bold
- Add an Image, Text Color, Background Color, Bold formatting
- Enter a description to add a legend explaining the highlighting

Add available filters
Define filters, on the Available Filters tab, allowing users to limit and refine the search results:

- Select the field from the pop-up window or use Add Multiple
- Choose to Show in Filter Region, Show as Multi-Select (optional)
- Enter an Label (optional)
- Filters will then display in the footer of the search results

Activity: True or False

<table>
<thead>
<tr>
<th>Indicate if the statement is true or false.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Transaction searches default to header-level information.</td>
</tr>
<tr>
<td>2. Joins allows you to display more detailed information, pulling information from a related record.</td>
</tr>
<tr>
<td>3. I can highlight anything I want, even it if it is not part of search criteria.</td>
</tr>
<tr>
<td>4. Available filters allow users to see a subset of the search results.</td>
</tr>
</tbody>
</table>
Share a Saved Search

Print, export or email results
Search results may be shared through Print, Export, and Email functions:

- User must have the Export Lists permission to expose the Export button when viewing search results
- Click Print to print your search results to a local printer
- Choose which Export option you want
  - Export – CSV can be used to export out a file for import to another system
  - Export – Excel facilitates further manipulation and graphing of the data

Track executions – available to Administrators or users with Publish search permission
Edit the search and click on the Execution Log subtab

- Track executions and exports of saved searches
- View a history of the last 60 days

Manage searches via Audit Trail
Click the Audit Trail subtab:

- Search properties tracked including top-level options, Criteria, Results, Available Filters, Audience, Roles, Email
- Drill-down onto details which supports expressions and operators

Best Practices

- **Design, design, design:** design your search before you start to construct it
- Determine the required fields for your criteria and results
- Look at records and transactions in NetSuite to familiarize yourself with where data “lives”
- If your search has anything to do with a transaction, start with a transaction search
- Reflect your criteria in your results
- Use Set Preferences to “Show List When Only One Result”
- By using a search (Type = Analytics Audit Trail), you can view properties of searches (and Reports) that have been deleted
## Activity: Match Game

Match the terms on the left to the task/description on the right

<table>
<thead>
<tr>
<th>Joins</th>
<th>Selects header, line-level detail, or both</th>
</tr>
</thead>
<tbody>
<tr>
<td>Criteria</td>
<td>Focus on critical information</td>
</tr>
<tr>
<td>Save and Run</td>
<td>Access fields on tables related to main search object</td>
</tr>
<tr>
<td>Mainline Setting</td>
<td>Set the display</td>
</tr>
<tr>
<td>Highlight if...</td>
<td>What are you looking for?</td>
</tr>
<tr>
<td>Results</td>
<td>Save your criteria and display your results</td>
</tr>
</tbody>
</table>

## Need More Information

### NetSuite Help Center Topics
- Using Saved Searches

### SuiteAnswers
- New Feature Training
- Saved Searches/Reports category
  - Saved Search: Creating Custom Search Forms
  - Saved Search: Pivot Reports BETA

## Now It’s Your Turn

For hands-on practice, you will:

- 01 - Create a Saved Search for Inline Editing
- 02 - Create a Saved Search List for Marketing
- 03 - Create an Overdue Customers Saved Search

### Tips
- Save your searches as you create them so you do not accidentally lose your search criteria if you navigate to a different page.
Hands-on Exercises
Create Saved Searches
Suggested Time to Complete Exercises: 20-30 minutes

01: Create a Saved Search for Inline Editing

Scenario
One of the primary tasks of the sales rep team is to work qualified prospects. To help them perform this task, you create a saved search that can be updated as the sales reps work the prospects.

To do their job successfully, the sales reps need to:
- Add or change information
- Change the status of the prospect
- Add the lead source if the information is missing

Reminder: Save your searches as you create them so you do not accidentally lose your search criteria if you need to navigate to a different area of the application

Create a New Saved Search

1. Go to Lists > Search > Saved Searches > New.
2. For the Search Type, click Customer.
3. In the Search Title field, enter Prospects to Contact.
   Tip: To make the saved searches easier to find later, add your initials to the beginning or end of the search name.
4. In the ID field, enter _sdr_prosp_contact.

Add the Saved Search Criteria

5. Go to the Criteria tab > Standard tab and set the Filter criteria:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stage</td>
<td>is Prospect</td>
</tr>
<tr>
<td>Status</td>
<td>is PROSPECT – Identified Decision Makers and, PROSPECT-Qualified</td>
</tr>
</tbody>
</table>
**Define the Search Results**

6. Click the **Results** tab and add, remove, and sort the columns to display as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Custom Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Prospect Name</td>
</tr>
<tr>
<td>Phone</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>Prospect Status</td>
</tr>
<tr>
<td>Lead Source</td>
<td>Prospect Source</td>
</tr>
</tbody>
</table>

**Note:** Custom fields are appended by (Custom) to identify them.

**Preview the Search**

7. Click the **Preview** button to check the results.
   NOTE: Turn off Inline Editing, if on.
   Click the **Return to Criteria** button to continue to refine your saved search criteria, if needed.

**Save & Run the Search**

8. Click **Save & Run** when you are done to view the results.
   **Hint:** Click the dropdown arrow to the right of the Save button if you cannot see **Save & Run**.
## 02: Create a Saved Search List for Marketing

### Scenario

Each year, the marketing team plans several regional road-show events. They need current customer lists with the associated sales rep for each region.

The marketing team is currently planning road shows that will be held in San Francisco and San Diego.

- They want to invite all the California customers and prospects who are committed to purchasing products.
- In particular, they want to be able to easily identify those customers that are located in San Francisco and San Diego.

To help them do this, you create a saved search that identifies all the California customers but highlights those in San Francisco and San Diego.

### Steps

1. Go to **Lists > Search > Saved Searches > New**.
2. For the **Search Type**, click **Customer**.
3. In the **Search Title** field, enter **CA Customer List**.
4. In the **ID** field, enter **_sdr_ca_cust_list**
5. Set the Criteria Filters:
   - **Filter = Status**
     - **Description =** is any of **Customer-Closed Won, Customer-Renewal, Prospect-Purchasing**
     - **Hint:** Hold the **Ctrl** key down to select multiple **Status** values.
   - **Filter = State/Province**
     - **Description =** **United States - California**
6. Click the **Results** subtab. Add, remove and reorder columns until you have the information for your invitation list. Some fields you might choose to add include:

- Name
- **Primary Contact**
- **Address 1**
- **City** (may also say Town/City)
- **State/Province**
- **Zip Code** (or Postal Code)
- **Phone**
- **Email**
- **Sales Rep**

7. Enter custom labels for the following columns:

<table>
<thead>
<tr>
<th>Field</th>
<th>Custom Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Company Name</td>
</tr>
<tr>
<td>Address 1</td>
<td>Address</td>
</tr>
</tbody>
</table>

8. Sort the list by **City** (or Town/City).

9. Click the **Highlighting** subtab and enter these two (2) conditions:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Background Color</th>
<th>Bold</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>City is San Francisco</td>
<td>Green</td>
<td>Yes</td>
<td>San Francisco</td>
</tr>
<tr>
<td>City is San Diego</td>
<td>Yellow</td>
<td>Yes</td>
<td>San Diego</td>
</tr>
</tbody>
</table>

10. Preview and refine the search criteria and results as needed.

11. Click **Save & Run** when you are done.
03: Create a Saved Search for Overdue Customers

Scenario
The A/R (Accounts Receivable) Clerk has asked you to create a real-time list of customers who are at least 20 days overdue on their payments.

- The list need to be available from the dashboard
- Customers who are severely overdue to be displayed differently for easy identification.
- Needs the contact details for each customer in order to follow up with them via phone and mail.

In this exercise, you create a saved search and add formatting to enhance the results.

1. Navigate to **Lists > Search > Saved Searches > New** and select the **Search Type**.

   Which search type did you choose?

   **Answer:**

2. Title the search: **Overdue Customers** and make the search available for the **Home Dashboard**.

3. Enter _sdr_overdue_cust in the **ID** field.

4. Set the **Criteria Filters** to capture customers that are greater than **20 days overdue**.

5. Click the **Results** tab. Add, remove and sort the columns so it is easy for the A/R Clerk to contact the customers and identify how many days each customer is overdue and how much they owe.

   Which columns did you add and how did you sort them?

   **Answer:**

6. Click **Save & Run**.

7. Sort the results by the **Days Overdue** column to identify three potential thresholds to highlight. For example: greater than 20, greater than 50, and greater than 100.

8. Click the **Edit this Search** button.
9. Click the **Highlighting** subtab and enter the following conditions in the order listed:
   - Records that are **30 days overdue** will display in bold.
   - Records that are **60 days overdue** will display with a light yellow background and bold text.
   - Records that are **90 days overdue and beyond** will display in red text, with a light yellow background, and in bold.

10. Enter the following descriptions to create the legend:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>30 Days Overdue</td>
<td>30+ days</td>
</tr>
<tr>
<td>60 Days Overdue</td>
<td>60+ days</td>
</tr>
<tr>
<td>90+ Days Overdue</td>
<td>90+ days</td>
</tr>
</tbody>
</table>

11. Click **Save & Run** to review the results. Click the **Edit this Search** button to continue working on the saved search, if necessary.

12. Click the **Edit this Search** button to reverse the order of the highlighting conditions:
   - Days Overdue is 90+
   - Days Overdue is 60
   - Days Overdue is 30

13. Click **Save & Run**.
03: Solution

1. Select the Search type.
   Which search type did you choose?

   Answer: *Customer*

   **Note**: if you’d chosen transactions, your search would work but would be list of overdue transactions. As the AR Clerk only wanted to know the customers, run the search on Customers not transactions.

4. Click the *Results* tab. Add, remove and sort the columns so it is easy for the A/R Clerk to contact the customers and identify how many days each customer is overdue and how much they owe.
   Which columns did you add and how did you sort them?

   Answer:
   - *Days Overdue*
   - *Overdue Balance*
07: Publishing Saved Searches

Introduction
Now that I can define a saved search, how can I:
• Ensure that only the appropriate roles have access to it?
• Provide users access to the search when and where they need it in the application?
• Guarantee that the saved search results are “actionable” — in other words, can I enforce Business Process Flows and tasks?

About this Module
This module examines how to publish saved searches so they are:
• Accessible to specific users only
• Viewable from multiple places in the application
• Display results in a way that helps facilitate user action

Objectives:
Upon completing this module, you should be able to:
• Define the audience for a saved search
• Publish saved searches to different application views
• Show saved searches in a menu
• Use saved searches as custom dashboard reminders
• Create saved search email alerts and scheduled emails
Defining Access for Saved Searches

Public Access
Saved Searches can be made available to all users:

- Select the Public check box
- Allow all roles and users access to the saved search
  - **Benefit:** Public saved searches can save employees time and ensure all users conduct searches using the same criteria
  - **Warning:** Too many public saved searches can become overwhelming and difficult to manage

Define Audience
Restrict access to specific audience members:

- Go to the Audience subtab
- Choose audience restrictions that facilitate minimal maintenance
  - For example: Choose roles instead of individual employees
  - Note: Be aware that if you select both a role and department, then the user must have that role and be assigned to the department
- Users must have permissions to the record type and related data to access the saved search

Allow Audience to Edit
Decide how audience member can edit the search:

- **Check** Allow Audience to Edit
  - Users can make changes to the saved search and can save it with the same name, i.e. overwriting the search
- **Do not check** Allow Audience to Edit
  - Users can make changes to the saved search but must save the search with a new name, i.e. cannot overwrite the search

Provide Different Search View

List View
Allow users to select saved searches from the bottom of list pages for the related record type

- Check the Available as List View box
- Users can then select the saved search from the View dropdown list.

Dashboard View
Available as Dashboard View makes search available in the List portlet

- Add the List portlet to the Home Dashboard
• Click **Set Up** and select the saved search record type
• Select the saved search as the **View** in the List portlet

**Create Sublist View: Preferred Method**
Provide different information to different roles on sublists:

• Go to the record’s subtab and then to the desired sublist
• Click the **Customize View** button
• Saved Search displays, choose **More Options** to use full capabilities

**Create Sublist View: Alternate Method**
Saved searches can be used to present a custom view of a sublist on a record subtab:

• Check the **Available as Sublist View** box so users can select the saved search from the View dropdown list on a subtab of a record.

**Publish Search**
Saved searches may be added to the Home Dashboard:

• Go **Home** and click the **Personalize Dashboard** link
• In the **Add Content** panel, select up to six custom search portlets
• Close the panel
• Click **Set Up** in each Custom Search portlet and select your search

**Activity: True or False**

<table>
<thead>
<tr>
<th>1. Checking <strong>Public</strong> makes the saved search available for all roles, departments, etcetera?</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. If <strong>Allow Audience to Edit</strong> is checked, then the user working with that saved search must save it with a new name.</td>
</tr>
<tr>
<td>3. Check <strong>Available as Dashboard View</strong> to allow the saved search to reside in one of the three (3) Custom Search portlets.</td>
</tr>
<tr>
<td>4. Users can customize their view of sublists.</td>
</tr>
</tbody>
</table>

© NetSuite Inc.  Duplication is prohibited  73
Enforce Business Process Flow and “Action”

Create links in menu paths
Create a link in the menu paths:

- Check the **Show In Menu** box
  - Saved searches available from the **Reports > Saved Searches** menu

**Caution:** This may not be the best practice – a lot of saved searches could end up in this menu and become difficult to find.

**Tip:** Consider adding the saved search as a shortcut on your Dashboard.

Create custom reminders
Base custom reminders on the number of results from a saved search:

- Name the saved search to reflect an appropriate reminder name to be displayed in the Reminders portlet
- Check the **Available for Reminders** box to make the saved search available from the Reminders portlet
- Click the **Set Up** in the Reminders portlet to add the saved search to the Reminders portlet list
- Drill down on custom reminders to view the results

Create email alerts
Improve job function or Business Process Flow by notifying users, automatically, about records being created or updated:

- Enable email alerts when records are created/updated
- Enable the **Send on Update** option to include updates, as well as adds, in email alerts to the recipients
- Send alerts when specific field values change
- Check **Include View Record Link** to display record links in email alert messages

Set up scheduled emails
Send Scheduled Emails, with results relevant to the user, on a regular basis

- Select **Send Emails According to Schedule**
- Specify frequency for Scheduled emails with matching results are sent
- Display saved search results as an attachment or within email message
- Deselect **Send if No Results** to prevent sending unnecessary emails

Change default saved search email sender
By default, saved search emails are sent from the search owner’s email address. Alternatively, you can:
• Set the **From Address for Search Emails** preference to define the email address of your choice as the default sender for all saved search emails
  o **Setup > Company > Printing, Fax & Email Preferences > Email** subtab
  o Follow the required format: “name” <email address>
• Define a non-default sender for a saved search email to override the email address set in the company preference, for that search only
  o Edit the search and go to the **Email subtab > Customize Message subtab**, and then enter the email address in the **From** field

### Email Alerts vs. Scheduled Emails

<table>
<thead>
<tr>
<th>Feature</th>
<th>Email Alerts</th>
<th>Scheduled Emails</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DELIVERY</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sends emails when specified records are created/changed</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Sends emails on a scheduled basis containing relevant search results</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td><strong>RECIPIENTS</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Specific Recipients tab defines individual person(s) or group(s) to receive emails</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Allow users to subscribe to the email</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Recipients derived from results fields</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td><strong>MESSAGE</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Updated Fields: If used, specific fields and/or changes in field values are required to produce an email alert</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Customize email message content</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Customize message for Single Record Results</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

### Best Practices

The following are the recommended, best practices for email alerts and scheduled emails:

• Enable **Allow Users to Subscribe** to allow other users, not identified as recipients, to subscribe to saved search alerts
• Schedule a large, saved search to prevent it from timing out
• Use both email alerts and scheduled emails on the same saved search, if necessary/desired
• Schedule searches to run the following day if you want the search to include information up until the end of a particular day (it’s likely that you will also have to set date parameters in your search criteria)
Activity: Match Game

Match the terms on the left to the task/description on the right

<table>
<thead>
<tr>
<th>Audience</th>
<th>Select saved search in List portlet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available as Dashboard View</td>
<td>A list of records related in some way to the record being viewed</td>
</tr>
<tr>
<td>Sublist</td>
<td>Sends emails on a regular basis</td>
</tr>
<tr>
<td>Email Alerts</td>
<td>Users who have been given access to the saved search</td>
</tr>
<tr>
<td>Available as List View</td>
<td>Select view from a list of records</td>
</tr>
<tr>
<td>Scheduled Emails</td>
<td>Notify users about records being created or updated</td>
</tr>
</tbody>
</table>

Need More Information

NetSuite Help Center Topics
Using Saved Searches > Defining a Saved Search

SuiteAnswers
New Feature Training
Go to the Saved Searches/Reports category:
- Saved Search: Adding Grand Totals and Exporting Results
- Saved Search: Email Alerts and Scheduled Emails Overview
- Saved Search: Set Up Email Alerts
- Saved Search: Set Up Scheduled Emails

Now It’s Your Turn

For hands-on practice, you will:
- 01 - Add Filters and Restrict Access to a Saved Search
- 02 - Create a Saved Search for a Sublist View
- 03 - Create a Saved Search with an Email Alert
- 04 - Add a Saved Search Email to an Existing Search
- 05 - Create a Saved Search (Email Alert & Scheduled Email)
Hands-on Exercises
Publish Saved Searches
Suggested Time to Complete Exercises: 30 -45 minutes

01: Add Filters and Restrict Access to a Saved Search

Scenario
One of the primary tasks of the sales rep team is to work qualified prospects.
You created the Prospects to Contact saved search earlier.

- Now restrict access to just the sales reps.
- Additionally, the sales reps need to sort the results by status and source

In this exercise, return to the Prospects to Contact saved search that you created in Exercise 06 – 01 to customize it some more.

Add Filters to a Saved Search

1. In the Global Search, type in sea: Prospects to Contact. As you type, the search should appear as an option to select. Click on the Edit link.

2. Click the Available Filters subtab and add the following filters:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Show in Filter Region</th>
<th>Show as Multi-Select</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Yes</td>
<td>No</td>
<td>Prospect Status</td>
</tr>
<tr>
<td>Lead Source</td>
<td>Yes</td>
<td>Yes</td>
<td>Source</td>
</tr>
</tbody>
</table>

Restrict Access to a Saved Search

3. Click the Audience subtab and from the Roles list select the Sales Rep – US East and Sales Rep – US West roles.

Tip: Press the Ctrl key on your keyboard to select multiple roles.

Preview and Save

4. Click Preview to see results and click Return to Criteria to make changes as necessary. Save or Save and Run when you are done.

5. Add the saved search to the Home Dashboard if necessary. Go to the Home Dashboard. Click the Set Up link in the Custom Search portlet.

6. Select Prospects to Contact from the Search dropdown list.

7. Click Save.

Add the Saved Search to the Home Dashboard

8. Click the Home tab and click the Personalize link in the upper right-hand corner.

9. Add a Custom Search portlet from the Standard Content offerings.
10. Close the Personalize page by clicking on the **Personalize** link again.

11. Click the **Set Up** link in the **Custom Search** portlet and select **Prospects to Contact** from the **Search** dropdown list.

12. Click **Save**.

---

**02: Create a Saved Search for a Sublist View**

**Scenario**

Because CRM activities are so important to SuiteDreams business, management would like:

- A defined view of activities that allows users to immediately pick out the status of the activity
- Displays only the information that is used internally.
- Because notes related to activities are important, management wants to remove the mark completed option, so users must edit their activities and enter notes before marking an activity as complete.

**Create a New Saved Search List**

1. Locate and edit the **Fabre Technology** customer record.

2. Navigate to the **Communication** subtab, and then to the **Activities** sublist. Be sure that the **View** dropdown is set to **default**, and then click **Customize View** on the **Activities** subtab to create a new sublist saved search.

3. In the **Search Title** field, enter **SuiteDreams Activities Status View**.

4. Click the **More Options** button.

5. Be sure that the **Available as Sublist View** checkbox is checked, and check the **Public** checkbox.

**Set the Saved Search Criteria**

6. Leave the search criteria **blank**, to return all activities.
**Define the Search Results**

7. Click the Results subtab. Add and/or remove columns in the search, until the results columns display as follows:
   - Type
   - Title
   - Date
   - Time
   - Notes
   - Status
   - Assigned to
   - Priority

8. Set the Sort order for this sublist view to **Date: Descending**.

**Add Highlighting Preferences**

9. Click the Highlighting subtab and set the following conditions:
   - When the Status is None of: Completed or Tentative, set the text color to a dark green, make it bold, and set the description to read: **Scheduled/In Progress**.
   - When the Status is Any of: Tentative, set the text color to a dark orange, bold the text, and add an orange flag image. The description should read: **Tentative Appointment**.
   - When the Status is Any of: Completed, leave all text as normal/default.

**Set Available Filters**

10. Click the Available Filters subtab, and add the following filters (to the existing list):
   - Assigned to
   - Priority

Now, users can further refine the activity list by priority and by who the activity is assigned to.

**Set Preferred Views**

11. Click the Roles tab and make this saved search the Preferred Sublist View for all roles. This will allow all roles to set this view as a company standard.

**Hint!** You need only to check one box to accomplish this!
Save the Search

12. Click Save to save the search results; you should be returned to the original customer record from which you started. If not, use the Recent Records to return to Fabre Technology.

13. Navigate to the Communication subtab, and then to the Activities subtab to view your search results!

14. Click the Customize View button to make changes if necessary by returning to criteria and then re-saving.

03: Create a Saved Search with an Email Alert

Scenario In order to retain customers, sales reps are looking for an easy way to be alerted when customer support cases are escalated or re-opened for any of their customers.

- This allows the reps to proactively contact the customer to help resolve the problem
- Do some relationship building to preserve the account.

In this exercise, you create a saved search email alert to warn sales reps when support cases are escalated or re-opened.

Please note that with our training accounts, we cannot send email alerts. Email alerts are sent to the email listed on an employee record.

Create the Saved Search Criteria

1. Navigate to Lists > Search > Saved Searches > New. Select Case as the Search Type.

2. Name the saved search Escalated Customer Support Cases. Enter _sdr_esc_supp_case in the ID field, and make the search available as a List View and as a Dashboard View.

3. Go to the Criteria subtab > Standard subtab and set the Filter criteria:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>is any of Escalated, Re-Opened</td>
</tr>
<tr>
<td>Assigned To</td>
<td>is Cameron Murdock</td>
</tr>
<tr>
<td>Customer :Sales Rep</td>
<td>is Larry Nelson</td>
</tr>
<tr>
<td>Date Created</td>
<td>is on or after end of three fiscal years ago</td>
</tr>
</tbody>
</table>
Define the Search Results

4. Click the Results: add, remove, and sort the columns to display as follows:
   ▪ Number
   ▪ Subject
   ▪ Company
   ▪ Contact
   ▪ Email
   ▪ Stage
   ▪ Status
   ▪ Date Created
   ▪ Type
   ▪ Assigned To
   ▪ Priority
   ▪ Customer Fields: Sales Rep
   ▪ Customer Fields: Primary Contact

5. Sort the search results by Company name.

Setup the Email Alert

6. Click the Email subtab and setup the email alert:
   ▪ Check Send Email Alerts When Records Are Created/Updated box
   ▪ On the Specific Recipients subtab:
     ▪ Click the “fast forward” (double arrows) to add a recipient
     ▪ Click “List”; change the top dropdown filter from All to Employee
     ▪ Add Larry Nelson as the Recipient
   ▪ Check Send on Update
   ▪ Check Show Recent Changes
   ▪ Click Add
7. Click the **Updated Fields** subtab and select **Status** as the field that we are monitoring for changes, and set the following conditions:

<table>
<thead>
<tr>
<th>Field</th>
<th>When Old Value is…</th>
<th>When New Value is…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>In Progress</td>
<td>Escalated</td>
</tr>
<tr>
<td>Status</td>
<td>Closed</td>
<td>Re-Opened</td>
</tr>
</tbody>
</table>

8. On the **Customize Message** subtab:
   - In the **Subject** line, enter **Case Status Change** for the email subject. Note: If a subject is not entered, one will be created by NetSuite.
   - In the **Introduction** field, enter “A case for one of your customers has been escalated or re-opened."

   **Note:** By default, saved search emails are sent from the search owner’s email address, unless a default email address has been set up in the company preferences. If desired, you could enter an email address in the **From** field to override the default. If you enter an email address, follow this format: “name” <email address>

9. Verify that the **Include View Record Link** box is checked.

**Save & Run the Search**

10. Click **Save & Run** when you are done to view the search results.
    The search results should list cases assigned to **Cameron Murdock** with **Larry Nelson** as the sales rep.

11. Click the **View** link next to case **#8 – Access to Manager Self Service** to drill down to the record details.

   In a real – production – account, whenever any data changes on this case record, an email alert, with the details of the recent changes, will be sent to Larry Nelson.
   Additionally, whenever the status of any of Larry’s customers’ cases changes from In Progress to Escalated or from Opened to Re-Opened, an alert will be sent to Larry Nelson.
04: Add a Saved Search Email to an Existing Search

Scenario

Let's add on to the search created for Overdue Customers (from Exercise 06 – 03) to create a daily email list of overdue clients.

The Overdue Customers search highlights customer that are at least 20 days overdue on their payments. Now, we’ll add to that search so it automatically emails the results on a daily basis to the A/R Clerk and other pertinent users in Accounts Receivable.

1. Navigate to Lists > Search > Saved Searches. Alternatively, you can search for the saved search by entering sea: overdue customers in the Global Search box.

2. Click the Edit link to the left of the Overdue Customers Search created in a previous exercise.

3. Check the Public box so users can subscribe to this saved search email.

4. Click the Email subtab and select the following checkboxes to enable the saved search emails based on a schedule:
   - Check Send Emails According to Schedule
   - Check Summarize Scheduled Emails (defaults automatically)
   - Uncheck Send if No Results (defaults automatically) so emails won’t be sent if there are no results in the saved search

5. Go to the Specific Recipients subtab and add the following:
   - Allow users to subscribe
   - Send the weekly email to: Larry Nelson and Wes Brown in the Accounts Receivable department

6. Click the Customize Message subtab
   - Add a subject line: Overdue Customers
   - Add an introduction: Customers 20 or more days overdue

7. Send the search results as a Microsoft Excel attachment.

8. Click the Schedule subtab and set the schedule to occur daily, with an end date of the final day of the current week.

9. Click Save & Run. In a real/production account, an email with the search results would be sent daily to the recipient(s).
05: Create a Saved Search (Email Alert & Scheduled Email)

**Scenario**
In this exercise, you create a saved search with an email alert and a scheduled email to keep track of the progress of tasks that you have assigned to others.

As a manager, you assign tasks to others. Instead of monitoring a list of tasks you have assigned, you will use the saved search email function to have that list of tasks and the associated progress emailed to you on a scheduled basis. In addition, you will set up an alert to identify all tasks assigned by you to others that have been marked as complete.

In preparation for this exercise, you need to create and assign a couple of tasks to others. To test for the alerts, you will also need to change their status when the search has been fully setup.

**Create Two Tasks and Assign to Others**

1. Navigate to your **Home Dashboard**, and select **New Task** link under the **Create New icon** to enter new tasks.
2. Create the first task.
   A. Enter the following information in the task record:
      - **Title**: Create New Procedure Presentation
      - **Assigned to**: Frances Murphy
      - **Start Date**: Today’s date
      - **Due Date**: One week from today
      - **Priority**: Leave as Medium
      - **Status**: Leave as Not Started

   B. Select/click **Save & Copy** to edit and create a second task.
   C. Enter the following for the second task:
      - Assign the second task to James Rollings.
      - **Start Date**: Today’s date
      - **Due Date**: One week from today
      - **Priority**: Leave as Medium
      - **Status**: Leave as Not Started

   D. Click **Save**. You have created two tasks.
Create a Saved Task Search with a Scheduled Email and an Email Alert


4. For the Search Type, select Task.

5. In the Search Title field, enter Tasks Assigned to Others. In the ID field, enter _sdr_tsks_assign_other.

6. Make the search Public and check the Available as List View, Dashboard View, and Sublist View boxes.

7. Set the Criteria Filters:
   - Filter = Created by
   - Description = Larry Nelson
   - Filter = Assigned to
   - Description = is NOT Larry Nelson

8. Click the Results subtab.
   Add and remove fields until you have the information you would like to see when reviewing tasks assigned to others.
   Be sure the Assigned to and Status fields are included in your search results.
   Sort the search results by:
   - Who the task is assigned to
   - The status in descending order

   Enter custom highlighting for the following statuses:

<table>
<thead>
<tr>
<th>Field</th>
<th>Condition</th>
<th>Text Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Not Started</td>
<td>Red, Bold</td>
</tr>
<tr>
<td>Status</td>
<td>In Progress</td>
<td>Green, Bold</td>
</tr>
</tbody>
</table>

   Note: Add the highlighting criteria individually to set the text color for each.

10. Click the Available Filters subtab.
    Add the Status field as an available filter, and Show in Filter Region. Enter the label: Task Status.
    By adding the status filter, users will be able to further filter the list of tasks to include or not include certain statuses (as this search will include completed tasks).
11. Select the Email subtab:
   A. Check the following boxes on the main Email subtab:
      - Send Email Alerts When Records Are Created/Updated
      - Send Emails According to Schedule
      - Summarize Scheduled Emails
   B. Uncheck the following box:
      - Send if No Results
   C. Go to the Specific Recipients subtab:
      - Add Larry Nelson as a recipient
      - Check Send on Update
      - Check Show Recent Changes
   D. Click the Updated Fields subtab:
      - Select Status as the field, leave When Old value is field blank
      - Enter Completed in the When New value field. This will add the functionality of an email alert to be sent to Larry Nelson when any task is marked complete.
      - Click Add.
   E. Select the Customize Message subtab:
      - Enter a subject line and introduction
      - Choose Summarized Results Send within Message.

Verify that Include View Record Link is checked.

12. Complete the Schedule subtab to email search results on a daily basis, ending on the final day of the current week. Normally, you might choose to schedule this email on a weekly basis; however, for training purposes, daily is required!

13. Click Save & Run when you are done to view the results.

**Note:** You should also have a Task Status filter (dropdown menu) at the top-left side of your search results – allowing users to filter out completed tasks on-the-fly.
08: Adding In-Depth Analysis

Introduction
Now that I know how to create and publish saved searches, how can I get more information from the results?

About this Module
In this module, we study how to create complex analyses so we can extract greater business intelligence from our NetSuite data.

We'll answer such questions as:
- How can I get results based on specific requirements?
- Can I group data in my columns and show totals to provide a report-style look

Objectives:
Upon completing this module, you should be able to:

- Use simple expressions facilitating different search logic
- Build combinations of criteria with parenthetical expressions
- Group data by column values for summarized results
- Highlight summarized results
- Add grand totals to numeric and currency columns
Saved Searches: “and” Logic

By default, Saved Searches with > 1 criterion employ “and” logic

When > 1 filter set, the results will match all the criteria
- For example: Saved Search for Support Cases with two criteria filters: 1) Created within this fiscal year, 2) Assigned to Aubrey Pober
  - Results will list all cases created within this fiscal year AND assigned to Aubrey Pober

You can move away from the “and” logic by using expressions

Simple and Parenthetical Expressions

**Simple expressions**
Check the **Use Expressions** box to create criteria segments, using additional Boolean operators:

- Change the logic to **OR**: Records or transactions can match any criteria in a string
- Use **Not** logic: Records or transactions can be excluded from the search results

**Parenthetical expressions**
Use parentheses to control the evaluation of expressions:

- Ensure that all segments have balancing opening and closing parenthesis

**Nested parenthetical expressions**
Expressions can be nested

- For multiple levels of nesting, precedence is granted to the most deeply-nested expressions
Activity: Question Time

1. By default, what logic does a saved search employ?
2. What is the operator I use to exclude a value?
3. How can I control the evaluation of my expressions?
4. If I use nested expressions, which one is the starting point?

4 QUESTIONS!

Summarize and Total Search Results

Display saved search results with report-like functionality. View the summarized search results:

- Drill into detail
- See totals on detail page
- Click Return to Summary to see the summarized view results

Summary Types and Show Totals

Group data by summary types
Summary types allow for a grouped or rolled-up view of the data

Define a Summary Type for a results column to display a total value for the column data, rather than individual record values
Provide a summary label, for the count of cases, for a more meaningful column heading

<table>
<thead>
<tr>
<th>Summary Type</th>
<th>Purpose</th>
<th>Example for Sales Order Transaction Search</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>Rolls up search results for the column.</td>
<td>Group transactions by customer name.</td>
</tr>
<tr>
<td>Count</td>
<td>Counts the number of results that apply to the column.</td>
<td>Count the number of items purchased by each customer.</td>
</tr>
<tr>
<td>Sum</td>
<td>Sums search results for the column.</td>
<td>Sum the dollar amount of the sales orders per customer.</td>
</tr>
<tr>
<td>Minimum</td>
<td>Shows the minimum amount found for the column.</td>
<td>Show the minimum amount sold in a transaction for each customer.</td>
</tr>
<tr>
<td>Maximum</td>
<td>Shows the maximum amount found for the column.</td>
<td>Show the maximum amount sold in a transaction for each customer.</td>
</tr>
<tr>
<td>Average</td>
<td>Calculates the average amount found for the column.</td>
<td>Show the average amount sold in a transaction for each customer.</td>
</tr>
</tbody>
</table>
Select a value to group your results by and then provide quantitative results to that group such as: count, sum, minimum, maximum and average:

Group cases by company
Return a count of cases for each company

**Summary by criteria filters**
Refine summarized search results to match specific conditions and show a subset of results

Filter the search criteria based on summary values
  - Example: Number of transactions is less than 5

**Highlight summarized results**
Use highlighting in conjunction with your summaries to draw attention to specific results

Click the **Highlight if… (Summary)** subtab to enter highlight conditions for summarized results

For example: Highlight customers with a count of transactions greater than or equal to 5 with a background color of yellow and in bold text

**Show totals**
Add grand totals to the detail view of search results

Check the Show Totals check box on the Results subtab
Total displays for columns with quantitative results, e.g. amount of transaction; does not apply to percent columns
Activity: True or False

Indicate if the statement is true or false.

1. Saved searches can only display a list of results, rather than a report-style view of results.
2. If using Summary Types, be sure to Group one of your values before applying quantitative summary types to your other results.
3. Drill-down capability is not available in a Saved Search.
4. Only Standard Criteria filters may be applied, therefore you cannot get to a subset of your search results.

Best Practices

Think through and talk through how you want your search to behave
Utilize expressions for more complex search results
Work with summary types to provide grouping of data
Highlight to focus on critical information

Need More Information

NetSuite Help Center Topics: Using a Saved Search
Defining a Saved Search

SuiteAnswers
Search for answers to your search and training-related questions
Go to Training Videos to access the complete self-paced training library

Now It’s Your Turn

For hands-on practice, you will:
01 - Create a Saved Search with an Expression
02 - Create a Saved Search Using Summary Types
03 - Create a Saved Search with Grand Totals
Hands-on Exercises
Add In-Depth Analysis
Suggested Time to Complete Exercises: 15-20 minutes

01: Create a Saved Search with an Expression

Scenario
SuiteDreams has an upcoming trade show and the marketing team wants a list of customers to invite. They want a list of customers in the US West subsidiary who have purchased specific items or have made a purchase within the last 12 months.

Create a New Saved Search

1. Go to Lists > Search > Saved Searches > New.
2. Click Customer as the Search Type.
3. In the Search Title field, enter Trade Show Invitees. In the Id field, enter _sdr_tradeshow_invite.

Enter the Criteria and Expression

4. In the Criteria subtab, check Use Expressions.
5. Set the Criteria Filters as follows:

<table>
<thead>
<tr>
<th>Paren</th>
<th>Filter</th>
<th>Description</th>
<th>Paren</th>
<th>And/Or</th>
</tr>
</thead>
<tbody>
<tr>
<td>(</td>
<td>Items Purchased</td>
<td>is any of Convertible Sofa, Mesh Chair, Urban Dining Table</td>
<td></td>
<td>And</td>
</tr>
<tr>
<td></td>
<td>Subsidiary</td>
<td>is Headquarters: Americas: US - West</td>
<td></td>
<td>Or</td>
</tr>
<tr>
<td>(</td>
<td>Purchase Dates</td>
<td>is within previous one year</td>
<td></td>
<td>And</td>
</tr>
<tr>
<td></td>
<td>Subsidiary</td>
<td>is Headquarters: Americas: US - West</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Define the Results
6. Click the Results subtab and add, remove, and order the columns as follows:
   - Name
   - Primary Contact
   - Phone
   - Email
   - Date of First Sale
   - Subsidiary

Save the Search
7. Click Save & Run.

02: Create a Saved Search Using Summary Types
Scenario
The CEO would like a report that displays the total count of completed sales over the last 12 months.
- Needs a see a summary of all the orders for each customer plus a total for the year.
- Needs to view it from his Home Dashboard, but does not want anyone else in the company to view the same list.

Create a New Saved Search
1. Go to Lists > Search > Saved Searches > New.
2. Click Transaction as the Search Type.
3. In the Search Title field, enter Orders Per Customer. In the ID field, enter _sdr_orders_customer.
4. Check the Available as Dashboard View check-box.

Define the Criteria, Results and Output Type
5. Set the Criteria Filters as follows:
   - Type = is any of Cash Sale, Invoice
   - Main Line = Yes (True)
   - Date = within previous one year
6. Click the Results subtab and remove the Memo and * columns.
7. Add the following **Summary Types** and **Custom Labels**:

<table>
<thead>
<tr>
<th>Field</th>
<th>Summary Type</th>
<th>Custom Label</th>
<th>Summary Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Number</td>
<td>Count</td>
<td></td>
<td>Number of Orders</td>
</tr>
<tr>
<td>Name</td>
<td>Group</td>
<td>Company Name</td>
<td>Company Name</td>
</tr>
</tbody>
</table>

8. Change the Order so that **Name** appears before **Transaction Number**

9. In the Sort By select **Transaction Number** then check **Descending**. This will make the customers with the most orders appear at the top of the results.

10. Click the **Available Filters** subtab. Set the following filter:
    - Filter = **Date**
    - Show in Filter Region = **Yes**

**Define the Audience and Define Preferred Views**

11. Click the **Audience** tab.

12. Select **CEO** from the **Roles** list.

13. Click the **Roles** tab.

14. Check the **Dashboard** box for the **CEO** role.

**Save & Run the Search**

15. Click **Save & Run** when you are done to view the results.

**Add the Saved Search to the Home Dashboard**

16. Click the **Home** tab and then click **Personalize Dashboard**.

17. Select **Custom Search** from the content window, then close window. Click the **Set Up** link in **Custom Search** portlet.

18. Select **Orders Per Customer** from the **Search** dropdown filter and click **Save**.
03: Create a Saved Search with Grand Totals

**Scenario**

The CEO would now like to see grand totals for all the orders for which the cash sales have been deposited and the invoices have been paid.

In this exercise, you modify the saved search you created exercise 02.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Return to the <strong>Orders Per Customer</strong> saved search. Use <strong>Global Search</strong> to locate the search, or from the <strong>Saved Search</strong> list page, click the <strong>Edit</strong> link for the <strong>Orders Per Customer</strong> saved search. If the search results are displayed, click the <strong>Edit this Search</strong> button to return to the search definition page.</td>
</tr>
<tr>
<td>2.</td>
<td>Rename the search <strong>Orders Per Customer Grand Totals</strong>.</td>
</tr>
<tr>
<td>3.</td>
<td>Select <strong>Save As</strong>. This creates a new search using the pre-existing search as the basis. The old search <strong>Orders Per Customer</strong> is retained. Note that if you’d chosen <strong>Save</strong> it would have overwritten the old search with a new title.</td>
</tr>
<tr>
<td>4.</td>
<td>Click the <strong>Edit this Search</strong> button. <strong>Note</strong>: If a list of saved searches has returned instead of the report, run a <strong>Global Search</strong> for <strong>Orders Per Customer Grand Totals</strong>. Then click the <strong>Edit</strong> link next to the <strong>Orders Per Customer Grand Totals</strong> name.</td>
</tr>
<tr>
<td>5.</td>
<td>In the <strong>Criteria</strong>, add the following additional criterion to the existing criteria: - <strong>Amount Remaining is 0.00</strong></td>
</tr>
<tr>
<td>6.</td>
<td>Click the <strong>Results</strong> subtab.</td>
</tr>
<tr>
<td>7.</td>
<td>Remove the <strong>Summary Types</strong> and the <strong>Custom Labels</strong> for the <strong>Number</strong> and <strong>Name</strong> columns.</td>
</tr>
<tr>
<td>8.</td>
<td>Ensure that the <strong>Status</strong> and <strong>Amount Remaining</strong> columns display in the <strong>Results</strong>.</td>
</tr>
<tr>
<td>9.</td>
<td>Check the <strong>Show Totals</strong> box.</td>
</tr>
<tr>
<td>10.</td>
<td>Click <strong>Save &amp; Run</strong> to view the results.</td>
</tr>
<tr>
<td>11.</td>
<td>Scroll down on the results list to see that a Total has been added.</td>
</tr>
</tbody>
</table>
09: Applying Advanced Formatting and Calculations

Introduction
How can I present my results in a more meaningful way?

About this Module
This module introduces working with functions and creating formulas:

- Use NetSuite functions to format date and numeric values
- Build simple formulas to display calculated values

Objectives:
Upon completing this module, you should be able to:

- Employ functions for more useful formatting of results
- Build a simple formula to calculate values
- Identify when more complex SQL formulas are needed
Using Functions

Functions allow you to convert search results to more useful formats.

Example: Date column can be grouped and converted to “quarter”

Apply functions to specific search result columns, transforming date and numeric values into more useful formats:

- Convert a simple date to a date period
- Round numeric values
- Provide aging and ranking

In the saved search, go to the Results subtab:

Select the required Field
Go to the Function column, select the function from the drop-down list
Click Done to apply the selected function to the field

Using Functions with Results

Formatting date
Instead of adding a specific type of date field, utilize NetSuite functions to reformat a date to show a particular view

Available functions: Calendar Week, Day, Month, Quarter, Week of Year, and Year
If you group on the date first, then you provide another summary view of your information:
  - For example: Support cases by Customer and Quarter and then drill into quarterly details

Aging results
Apply aging to date fields, such as how many days have elapsed since a support case was created:

- Use function “Age in Days” and provide a Custom Label
Using Formulas Overview

Formulas in Saved Searches are very powerful and allow calculations to be undertaken at search run time, for example:

- A formula which adds 12 months to the transaction date returns the date when a warranty expires (using ADD_MONTHS function)
- A formula which ranks customers based on their annual spend (using RANK function)
- A formula which groups open sales invoices based on their due date (using CASE function)
- A formula which calculates the margin on a sale by taking the COGS value from the revenue (no function – just a simple calculation)
- A basic understanding of SQL will make using formulas in NetSuite easier – but note calculations on fields can be created without using SQL functions

Using Formulas

Add simple formula

Build simple formulas to display calculated values:

For example: Create a saved search on Inventory items and show the markup on inventory items
  - Add a Formula (Percent) column and build the formula
  - The calculation result displays as a Markup

Formulas and functions

Functions can be used with Formulas to provide more meaningful results:

For example: We want to see our Markup percent displayed out to tenths of a percent
  - Add a function to Round to Tenths
  - Markups then display as desired

Go further with SQL Expressions

We have learned to add depth to saved searches through the use of expressions, simple formulas, and functions.

NetSuite uses an Oracle database and SQL Expressions should follow Oracle syntax.

Search capability can be extended through using SQL Expressions:

For example: To express the days between an employee’s hire date and last review date, use FLOOR in a SQL expression:
  FLOOR({lastreviewdate} – {hiredate})
  FLOOR is the numeric SQL (Structured Query Language) function that rounds down to integers equal to or less than the numeric value
  Inside the parenthesis is an expression to subtract the value in the NetSuite field “hiredate” from the value of “lastreviewdate”
Activity: Question Time!

1. How can I convert a date to display as a reference to a quarter?
2. What can I do if I want to display a calculated result?
3. I need my result to display as an integer, but it displays as 5.3333333. What do I do?
4. Can I do more than use simple expressions, formulas, and functions?

Need More Information

**NetSuite Help Center Topics: Using a Saved Search**
Defining a Saved Search

**SuiteTraining**
SuiteAnalytics: Advanced Searches

**SuiteAnswers**
Search for answers to your search and training-related questions
Go to Training Videos to access the complete self-paced training library

Now It's Your Turn

For hands-on practice, you will:

01 - Create a Saved Search – Ordered More Than One Item
02 - Create a Saved Search – Spending Amount Average
03 - Sum Customer Balances by Territory
04 - Customer Overdue Balance Measure (Optional)
Hands-on Exercises
Apply Advanced Formatting and Calculations
Suggested Time to Complete Exercises: 30 - 40 minutes

01: Create a Saved Search – Ordered More Than One Item

Scenario
The Marketing Manager wants to identify customers who have purchased more than one dining table, figuring this would identify either corporate customers, such as designers, or customers with large or multiple homes.

In this exercise, you create a search to find all customers who have ordered more than one of a particular item. Note that this search will also show you customers who have bought more than 1 of multiple items.

1. Go to the New Saved Search page. Reports > Saved Searches > All Saved Searches > New
2. Click Transaction as the Search Type.
3. Enter Ordered More Than One Dining Table in the Search Title field. Enter _sdr_ordered_more_one_dining_table in the ID field.
4. Check the Available as Dashboard View box.
5. In the Criteria > Standard subtab, enter the following:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>is Order (note: may appear as Sales Order)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>DINING ROOM : Barrow Dining Table</td>
</tr>
<tr>
<td>DINING ROOM : Bon Ton Dining Set</td>
</tr>
<tr>
<td>DINING ROOM : Loft Dining Table</td>
</tr>
<tr>
<td>DINING ROOM : Modern Wood Dining Set</td>
</tr>
<tr>
<td>DINING ROOM : Parsons Dining Table</td>
</tr>
<tr>
<td>DINING ROOM : Steel Round Table</td>
</tr>
<tr>
<td>DINING ROOM : Teak Dining Table</td>
</tr>
<tr>
<td>DINING ROOM : Urban Dining Table</td>
</tr>
</tbody>
</table>

6. Click the Results subtab and ensure you have at least the following defined:

<table>
<thead>
<tr>
<th>Column</th>
<th>Summary Type</th>
<th>Function</th>
<th>Custom Label</th>
<th>Summary Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Group</td>
<td>Quarter</td>
<td>Fiscal Quarter</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Group</td>
<td></td>
<td>Customer</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Group</td>
<td></td>
<td>Item</td>
<td></td>
</tr>
<tr>
<td>Quantity</td>
<td>Sum</td>
<td></td>
<td>Qty Ordered</td>
<td></td>
</tr>
</tbody>
</table>
7. Sort the results by Name.
8. Click Preview button.
9. Review the list (notice Total Found number), when finished click Return to Criteria button.
10. Click the Criteria > Summary subtab and enter the following:

<table>
<thead>
<tr>
<th>Summary Type</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sum</td>
<td>Quantity</td>
<td>is greater than 1</td>
</tr>
</tbody>
</table>

11. Click Add.
12. Click Save & Run when you are done.
13. Click any of the links to see the quantity breakdown.
14. Click the Return to Summary button.
15. Click Home to return to the Home Dashboard. Click the Personalize link and add a Custom Search portlet to the dashboard.
16. Add the Ordered More Than One Dining Table saved search to the Custom Search portlet.
02: Create a Saved Search – Spending Account Average

Scenario
To plan the sales strategy and better predict future revenue, the CEO needs to identify which customers are generating the most revenue and which ones are not. They would like to see a consolidated list of all customers in a grid.

The CEO needs to see:

- The total amount of all customer invoices
- The number of invoices from each customer
- The rank of each customer based on the amount of their invoices
- The percent of spending per invoice
- The average invoice amount

To help perform the analysis, they also need to have the flexibility to view the data from different perspectives.

In this exercise, you create a saved search with formatting and filtering options so users can refine the search results.

1. Go to Lists > Search > Saved Searches > New.
2. Click Transaction as the Search Type.
3. In the Search Title field, enter Spending Account Average. Enter _sdr_spend_acct_avg in the ID field.
4. Check the Available as Dashboard View box.
5. Set the Criteria filters as follows:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>is Invoice</td>
</tr>
<tr>
<td>Main Line</td>
<td>is Yes (True)</td>
</tr>
<tr>
<td>Status</td>
<td>is Invoice: Paid in Full</td>
</tr>
</tbody>
</table>

Tip: To avoid displaying multiple lines for each transaction in transaction search results, include a criterion of Main Line is True by selecting the Yes radial button.

6. Click the Results subtab.
7. Go to the Output Type dropdown list and select Grid.
8. Add, remove and sort the results columns as follows:

<table>
<thead>
<tr>
<th>Column</th>
<th>Summary Type</th>
<th>Function</th>
<th>Custom Label</th>
<th>Summary Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Group</td>
<td></td>
<td>Customer</td>
<td></td>
</tr>
<tr>
<td>Amount</td>
<td>Sum</td>
<td></td>
<td></td>
<td>Total of Invoices</td>
</tr>
<tr>
<td>Document Number</td>
<td>Count</td>
<td></td>
<td></td>
<td># of Invoices</td>
</tr>
<tr>
<td>Amount</td>
<td>Sum</td>
<td>Rank</td>
<td></td>
<td>Spending Rank (1 is low)</td>
</tr>
<tr>
<td>Amount</td>
<td>Sum</td>
<td>% of Total</td>
<td></td>
<td>% of Total Spend</td>
</tr>
<tr>
<td>Amount</td>
<td>Average</td>
<td></td>
<td></td>
<td>Average Invoice Value</td>
</tr>
</tbody>
</table>

9. Click the **Available Filters** subtab and enter the following:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Show in Filter Region</th>
<th>Show As Multi-Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Date</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

10. Click **Save & Run** when you are done to view the results.

11. Click the **Home** tab and add the **Spending Account Average** search to the **Custom Search** portlet. Select other values from the **Status** and **Date** filters to view different results. **Remember**: you may need to click **Refresh** in the **Custom Search** portlet before your newly created search is available for selection.
03: Sum Customer Balances by Territory

Scenario
The CFO is chasing bad debts, and wants to know which subsidiary managers are failing to reign in overdue customers.
Build this ‘report’ for the CFO using a Saved Search.
• Overdue balances groups by subsidiary
• Average number of days each subsidiary is overdue plus the total balance overdue per subsidiary.

Create a New Saved Search
1. Go to Reports > Saved Searches > All Saved Searches > New.
2. Click Customer as the Search Type.
3. In the Search Title field, enter Overdue Customer Analysis by Subsidiary. Enter _sdr_overdue_cust_sub in the ID field.

Define the Criteria
4. Set the first Criteria Filter to capture customers that have passed the Prospect or Lead stage:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stage</td>
<td>is Customer</td>
</tr>
</tbody>
</table>

Define the Results, Including Summary Types
5. Click the Results tab and enter summary information along with fields for display on the detail search results:

<table>
<thead>
<tr>
<th>Column</th>
<th>Summary Type</th>
<th>Function</th>
<th>Summary Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subsidiary</td>
<td>Group</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Days Overdue</td>
<td>Average</td>
<td>Round</td>
<td>Average Days Overdue</td>
</tr>
<tr>
<td>Overdue Balance</td>
<td>Sum</td>
<td></td>
<td>Total Overdue Balance</td>
</tr>
<tr>
<td>Name</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phone</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: the fields left ungrouped are the fields which display when you drill down from the search results.

Save the Search
6. Click Save and Run to view the results.
04: Customer Overdue Balance Measure (Optional)

Scenario
The accounting department regards balances that have been overdue for a longer period as ones that have a lesser chance of getting paid back.
- As one way to measure this, they would like to perform a simple calculation of Overdue Balance * Days Overdue, calling this “True Balance”.

We’ll need to execute a simple formula to measure this:
- The result should be displayed as a currency value, but rounded to the next highest whole number.
- The built in Round function goes to the nearest whole number.
- To go to the highest whole number we need to build a formula using the SQL expression CEIL.

1. Go to Reports > Saved Searches > All Saved Searches > New.
2. Click Customer as the Search Type.
3. In the Search Title field, enter Customer Overdue Balance Measure. Enter _sdr_cust_overdue_bal_measure in the ID field.

Define the Criteria
4. Set the first Criteria Filter to capture customers that have passed the Prospect or Lead stage:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stage</td>
<td>Is Customer</td>
</tr>
</tbody>
</table>
Define the Results, Including Summary Types

5. Click the Results tab and enter column information:

<table>
<thead>
<tr>
<th>Column</th>
<th>Formula</th>
<th>Custom Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overdue Balance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Days Overdue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Formula (Currency)</td>
<td>({\text{overduebalance}} \times {\text{daysoverdue}})</td>
<td>True Balance</td>
</tr>
<tr>
<td>Formula (Currency)</td>
<td>(\text{ROUND}\ ({\text{overduebalance}} \times {\text{daysoverdue}}))</td>
<td>True Balance (rounded)</td>
</tr>
<tr>
<td>Formula (Currency)</td>
<td>(\text{CEIL}({\text{overduebalance}} \times {\text{daysoverdue}}))</td>
<td>True Balance (higher integer)</td>
</tr>
</tbody>
</table>

Note: Enter \(\text{CEIL}(\{\text{overduebalance}\} \times \{\text{daysoverdue}\})\) with NO space between CEIL and parentheses. (See Below Image)

Save the Search

6. Click Save and Run to view the results. Notice how for True Balance values, ROUND goes to the nearest whole number, while CEIL goes to the highest number no matter the value of the decimal portion. A formula with ROUND should come with the same result as when using the built-in Round function.
10: Presenting Custom Metrics

Introduction
What if standard KPIs are not enough? We can build upon our knowledge of saved searches, by defining saved searches for use as custom metrics.

About this Module
In this module, we study how to create custom KPIs so you can display critical data in easy-to-read charts and graphs.

- Set up saved searches to display filtered data
  - Example: One sales branch might have different sales targets from another
  - Solution: Set up a custom KPI that shows sales from one branch only

Objectives:
Upon completing this module, you should be able to:

- Define custom KPIs
- Add summary functions to obtain added depth
- Display custom KPIs in the KPI portlet and as KPI Meters
Use Custom KPIs to…

Spot more specific trends in your business, for example:
  You need to track sales performance across 3 regions
    o Separate KPIs for each region let you know if sales are trending up or down, telling you how the reps in each region are performing
  Krista, the product manager for the Widget Deluxe products, tracks the number of cases associated with this line
    o Monitoring this trend tells her if there are any particular problems with the products she needs to act upon quickly
  Your operations manager tracks the average cost of items across three separate locations – Paris, Montreal and New York
    o KPIs warns him in advance if profitability in one of the locations is likely to change; pricing decisions can be made in advance of sliding profitability

KPIs: One Dimension

It is important to understand that KPIs only have one dimension.

Let’s assume we need to track sales performance across 3 regions
  o Separate KPIs for each are needed for this
  o Each KPI has one dimension only – Sales
  o Filters applied to each differently define the KPIs

So, EMEA vs. North America sales cannot be defined in a single KPI, as this would be two dimensions
  o They can, of course be setup as separate KPIs for comparative purposes
KPIs do allow two point-in-time comparisons, as shown

Saved Search: Custom KPI

Saved searches are the basis for custom KPIs:

Define the saved search adequately identifying the data to be included in the KPI
Use the required Summary feature to give your KPI meaning
  o If not summarized, NetSuite will return the count of matched records as the KPI
Building Custom KPIs

Apply filter to saved search
Apply whatever filters are required and appropriate for your Saved Search
- Filters limit the data that search returns
- Apply as many filters as required
  - Except Dates – don’t filter on dates, this is done in the Additional Filters

Summarize key results field
As discussed, KPIs only have one dimension
- This means, in theory, only one field is needed in the results tab of the search you are using for the KPI
- This field should have a summary defined in the Summary Type column
  - Sum, Average, Count, Minimize or Maximize
- If other fields are defined in the Results, these display when the user drills down to the search from the KPI.

Choose the most appropriate summary function to meet the requirement:
- Sum: totals the values of the selected field
  - Example: The Total Value of orders from the US-West branch office
- Minimum: returns the smallest value on the selected field
  - Example: The smallest customer spend in EMEA
- Maximum: returns the largest value on the selected field
  - Example: The date of the last (i.e. most recent) order of product Widget Deluxe
- Count: returns the number of records matched by the search criteria
  - Example: The number of orders shipped on a single day
- Average: the average value of the selected field
  - Example: The average amount owed to Vendors in Asia-Pacific

Add additional results fields for drilldown (optional)
Additional fields may be added to the Results
- They are not used by the KPI
- If the user clicks on the KPI from the Dashboard and drills down to the results, these fields then display
- Choose fields which support the intent of the KPI

Add date/period filters
Specify a Date or Period field as an Available Filter to create comparison ranges for viewing
- Any date field can be used – use the one that makes the most sense for the KPI
  - Example: using Due Date instead of Transaction Date on vendor bills would give vastly different meaning to the KPI
Alternatively, use the Period field
  o Terrific if the KPI relates to Financial transactions
If no Date or Period field is defined in the Available Filters, then two-point date comparisons of the KPI are not possible, and the KPI cannot be graphed.

**Custom KPIs on a Dashboard**

**Add a custom KPI to the KPI portlet**
Locate the KPI portlet on the Home Page, and then click the Setup link:
- Click Add Custom KPIs
- Select the custom KPI you need
- Click Done
  You can add up to ten (10) custom KPIs

**Configure a custom KPI**
If required, set comparisons and thresholds for each KPI:
- Compare and define complimentary Date Ranges
  Set a threshold using Highlight if...
  Display standard or custom KPIs in any order

**Configure popup trend graphs**
Select the Popup Trend Graphs subtab and configure the Data Text section
- Controls the chart type and behaviour
  Do you need to smooth out seasonal peaks (Show Moving Average)
  Do you want to start plotting from zero (Include Zero on Y Axis)

Configure the Visual Builder:
- Define the look of the chart with themes, background and color series selection

**View graphs of custom KPIs**
View graphs of the custom KPIs, just as you would a standard KPI:
- Click the View Graph icon
  Select the desired date range
  Download image to use in other applications
  Export to a .csv file

**Display a custom KPI in a KPI meter portlet**
Works like standard KPIs:
- Personalize Dashboard to add KPI Meter portlets
  Click View in the KPI Meter portlet
Select from the list of available KPIs
  o Custom KPIs must be displayed in the KPI portlet
Click **Set Up** to redefine your comparisons

**Activity: Question Time**

1. What key elements are required for a saved search to be used for a custom KPI?
2. How many custom KPIs can I add to the KPI portlet?
3. What behaviour do you configure for each KPI?
4. Can I display any custom KPI as a KPI Meter?

**Best Practices: Custom KPIs**

Do not specify a date range on the Criteria tab in your saved search. This is performed when you setup the KPI.
Have only one field with a Summary type (Average, Minimum, Maximum, or Sum) defined
Add a date or period filter on the Available Filters subtab of the saved search
Use KPI: as the prefix for the name of your Saved Search. This makes the use Saved Search easier to identify
Activity: True or False

<table>
<thead>
<tr>
<th>Indicate if the statement is true or false.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Custom KPIs cannot be displayed in the KPI portlet within standard KPIs</td>
</tr>
<tr>
<td>2. You cannot use custom KPI pop-up trend graphs outside of NetSuite</td>
</tr>
<tr>
<td>3. Any saved search will function as a KPI, displaying a pop-up trend graph and comparison</td>
</tr>
<tr>
<td>4. Always configure pop-up trend graphs to Start at Zero</td>
</tr>
<tr>
<td>4. Create Custom KPIs after reviewing Standard KPIs</td>
</tr>
</tbody>
</table>

Need More Information

NetSuite Help Center
SuiteAnalytics (Dashboards, Searches, &Reports) > Defining Custom KPIs

SuiteAnswers
Search for answers to your search and training-related questions
Go to Training Videos, Saved Searches/Reports category:
  o Key Performance Indicators: Putting Trend Graphs on Multiple Dashboards

Now It's Your Turn

For hands-on practice, you will:
  01 - Define a Custom KPI
  02 - Define a Custom Comparative KPI
Hands-on Exercises
Present Custom Metrics
Suggested Time to Complete Exercises: 10 minutes

01: Define a Custom KPI

Scenario
In this exercise, you define a custom KPI and then add it to the Home Dashboard.

The CFO needs to monitor the average available credit on all active customer accounts. To help him do this, you create a custom KPI for his specific needs.

Define a Customer Accounts Saved Search

1. Create a Customer saved search.

2. Name the search KPI: Average Available Credit. (You will want to use a standard naming convention to easily identify your KPIs.)

3. Filter the search criteria on customers with a balance greater than 1.00.

4. Click the Results tab and add a single Formula (Currency) field.
   Remove the following columns:
   - Industry Type (Custom)
   - Company size (Custom)
   - Office Phone
   - Fax
   - Alt. Email

5. Enter a formula to subtract the customers’ current balance from their credit limit. (Hint: use the popup to select the fields.)

6. Select Average from the Summary Type column to average the available credit on customer accounts.

7. Enter Available Credit as the Summary Label.

8. Add Date of First Order on the Available Filters subtab.

9. Click Save & Run when you are done.
Add a Custom KPI to the Home Dashboard
10. Click the Setup link in the Key Performance Indicators portlet.

11. Click the Add Custom KPIs button. From the list of available standard KPIs, select the KPI: Average Available Credit saved search that you just created.

12. Set the Range to this month and clear the Compare checkbox.

13. Click Save when you are done.

02: Define a Custom Comparative KPI
Scenario
In this exercise, you define a custom comparative KPI then add it to the Home Dashboard:
- The sales reps need to monitor how many leads they have created month by month.
- We create the search for Larry Nelson and publish it as a KPI.

Create a New Leads Saved Search
1. Create a Customer saved search.
2. Name the search KPI: New Leads – Larry Nelson
3. Filter the search criteria by Stage is equal to [any of] Lead and Sales Rep is Larry Nelson.
4. Click the Results tab and enter the following values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Summary Type</th>
<th>Summary Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Created</td>
<td>Count</td>
<td>Number of Leads</td>
</tr>
</tbody>
</table>

Remove the following columns:
- Industry Type (Custom)
- Company size (Custom)
- Office Phone
- Fax
- Alt. Email
5. Click the **Available Filters** tab. Select **Date Created** and check **Show in Filter Region**.

6. Click **Save & Run** when you are done.

**Add the New Leads**

7. Click the **Setup** link in the **Key Performance Indicators** portlet on the **Home Dashboard**.

8. Click the **Add Custom KPIs** button and select the **KPI: New Leads – Larry Nelson** saved search that you just created.

9. Set the **Range** to **this month** and **Compare** to **last month**.

10. Click **Save** when you are done.

This search could easily be replicated to other sales reps as needed, simply by changing the sales rep in the Filter then making the search available to the other sales reps. You would need one search for each sales rep.
11: Setting Up Trend Graphs and Scorecards

Introduction
Managers and executives need analytics-enabled dashboards to help measure performance and productivity:

- Leverage reports, saved searches, and custom metrics for insight
- Expose trend graphs in dedicated portlets

About this Module
In this module, we examine how to display critical data in trend graphs and how to dive deeper into your data by creating KPI scorecards.

What if you require more complex comparisons, across multiple time ranges for deeper analysis?

- KPI Scorecards allow comparisons across multiple time segments:
  - Delve deeper by comparing one KPI to another
  - Create complex, excel-like formula to expose the data you need

Objectives:
Upon completing this module, you should be able to:

- Set up and use trend graphs
- Display standard and custom trend graphs on dashboards
- Enable and build a KPI scorecard
**Trend Graphs**

Provide visual presentations of key metrics, over time:

- Can be added to most standard Dashboards:
  - Add trend graphs, up to 5, to the Home Dashboard
  - Place trend graphs to most standard Center tabs, such as Transactions or Opportunities
  - Put trend graphs on any Custom intranet tabs

Cannot be added to tabs that are not used as standard dashboards, such as:

- Activities
- Documents
- Setup

**Set Up and Use Trend Graphs**

**Add trend graphs to the Home dashboard**

Click **Personalize Page** on the Home Dashboard to open the **Add Content** panel

Open the **Trend Graph** folder and select up to five (5) trend graph portlets

Select **Standard Trend Graphs**

You may also select **Custom KPI Trend Graphs**

- Based on saved searches

Custom searches can only display by Date, they cannot display based on period

- Can only be displayed on dashboard that include a KPI portlet

Follow these same steps to add Trend Graph to other Dashboards

**Set up standard trend graph portlets**

Click **Setup** in the Standard Trend Graph portlet; define the attributes:

- **Default Chart Type**: Area, Line, Bar, or Column
- **Trend Type**: Daily, Weekly, Monthly, Quarterly, Yearly
- **Show Moving Average**: Smooth out data irregularities
- **Period to calculate moving average**: Set relative to trend type.
- **Hide or Show Last Data Point**: May want to exclude data for an incomplete period
- **Exclude or Include Zero on Y-Axis**
- **Chart Theme**: Global, Basic, Colorful, Match Color Theme – Bold or Light
- **Custom Color Series**: use hexadecimal value
- **Background Type**: Global, Lines, Bands, Grid

**Set up custom trend graph portlets**

Click **Setup** in the Custom KPI Trend Graph portlet

**Custom Trend Graph**: Select the saved search from the drop-down list

Define other attributes, as done with the Standard Trend Graph portlet
Activity: Question Time

1. How many trend graphs can display on the Home Dashboard?

2. How do I smooth out data from seasonal spikes?

3. What can I use if the standard trend graphs do not meet my need?

4. We are in week 1 of our quarter, which trend graph attribute should I disable?

KPI Scorecards

Obtain complex and in-depth trend analyses so you can gauge the health of your business:

- Track the profit performance of your services division on a monthly, quarterly, and annual basis
- Monitor the sales revenue generated across offices
- Calculate the ratio of COGS: Revenue over multiple periods; this is a key indicator of the health of your business
- Determine how traffic through your Website varies throughout the year, how holidays and seasons impact traffic
- Analyze Website conversion rates so you have a formula which subtracts New Customers from Unique Visitors; expressed as a percentage

Enable the KPI Scorecard feature

Go to Setup > Company > Enable Features > Analytics subtab:

- Go to the Dashboards section and select KPI Scorecards

Determine the requirements

The KPI Scorecard can have both Standard and Custom KPIs:

- Review the Standard Key Performance Indicators Table in Help
- Review the KPIs you may want to use in the scorecard
- Consider building Custom KPIs as needed
Define the Scorecard

Define a new KPI Scorecard
Define a new KPI Scorecard to be displayed on the dashboard

Navigate to Setup > Customization > KPI Scorecards > New
Name the scorecard; this becomes the title of the portlet
Enter an optional description

Select periods or date ranges
Execute the Scorecard by Date Ranges or enable Use Periods

Date Ranges require the custom KPI is based on a saved search with a Date filter
Use Periods requires that Accounting Periods are set up and the custom KPI is based on a saved search with a Period filter

When Use Periods is enabled, the subtab Date Ranges changes to Periods

Add custom KPIs
Go to the Content subtab, Custom sublist

The available Custom KPIs depend on if you are running the scorecard by date ranges or period filter

When using Date Ranges saved searches with a date filter are available to select in the Custom KPI drop-down list
If Use Periods is enabled, then saved searches with a period filter are available to select in the Custom KPI drop-down list

Add standard KPIs
Go to the KPI subtab and select KPIs from the drop-down list

Select from Standard KPIs
You may also choose your Custom KPIs, identified in the previous step

Set attributes and comparisons
Go KPI determine comparisons

Compare Value to: choose another KPI to compare to
Compare with Previous: compare a row, to a row above
Comparison Types: include Variance, Ratio and Sum
Use Invert Comparison: if you want to invert the operation used to calculate the comparison type
Less is More: if lower values are a desirable result, e.g. Payables have decreased.
   Downward arrow displays as green
Enter a Label for this column or row header in the Scorecard portlet
Add scorecard formula
Go to the KPI subtab and a formula type from the drop-down list

Formula (Currency), Formula (Numeric), or Formula (Percent)

Formula calculate KPI comparisons such as those used in MS Excel, and can include functions

Example: A Sales Manager gets a bonus on the deal conversion rate their team achieves. Set up the KPI with a formula that subtracts the Opportunities Lost from Opportunities Won

Type formula into formula field or use the Set Formula pop-up window
Click on the Set Formula icon
Choose the required KPI
Enter the formula in the Formula field, or use an SQL Function
Choose another KPI if required within the formula
Click Set to return the formula

Define the formula comparisons as you would the other KPI comparisons, additionally:

Hidden: to not display the formula in the scorecard, but you may be using this formula row compared to a row below
Example: Jim, the Widget product manager, is paid a bonus for keeping the ratio of cases logged: sales made below a certain level. His KPI scorecard contains a KPI Formula to calculate this ratio. A second formula calculation determines his bonus based on this ratio. He displays only the bonus in his scorecard.

Set date ranges or periods
Go to the Date Ranges (or Periods) subtab, select date ranges from the drop-down list, and then determine comparisons

Compare Value to: choose a date range for comparison
Compare with Previous: compare a row, to a row above
Comparison Types (optional) include Variance, Ratio and Sum
Use Invert Comparison (optional) if you want to invert the operation used to calculate the comparison type
Enter a Label for this column or row header in the Scorecard portlet

Set highlighting
Set up highlighting of KPI scorecard results when you are creating a new scorecard or editing an existing scorecard.

Make results more visible on in the KPI Scorecard portlet
Select each KPI and define the highlighting treatment
**Save and display the scorecard**
After all scorecard options are set – date ranges, comparisons and formula, click **Save** to save your scorecard.

Add the KPI Scorecard portlet and click **Set Up:**
- Select the **KPI Scorecard**
- **Restrict to:** data displayed either All, My Team or Only Mine
- Determine **Orientation:** KPIs or Date/Periods on left
- **Show Trend Graph Icon:** enable View Graph icon
- **Show Date Row:** display corresponding dates to ranges shown

**Best Practices: KPI Scorecards**

You can define multiple scorecards, but only one can be displayed on a dashboard at any time:
- Ensure that the KPI Scorecard you set up has enough of the required data defined on it
- Make sure you are comparing like KPI to like KPI, or else the Scorecard won’t have any meaning
- You don’t need to choose the same KPI
- If you do not want comparison results to display in the scorecard, check the Hidden box

Activity: Question Time

**Activity: True or False**

<table>
<thead>
<tr>
<th>Statement</th>
<th>True/False</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. KPIs are the columns in the KPI Scorecard</td>
<td>True</td>
</tr>
<tr>
<td>2. A custom KPI, based on periods, can be used in a scorecard that uses Date Ranges</td>
<td>True</td>
</tr>
<tr>
<td>3. Only one KPI Scorecard may be displayed on the Home Dashboard</td>
<td>True</td>
</tr>
<tr>
<td>4. Less is More displays downward trends as positive</td>
<td>False</td>
</tr>
</tbody>
</table>
Activity: Match Game

Match the terms on the left to the task/description on the right

<table>
<thead>
<tr>
<th>Average Window</th>
<th>Compare this row, with the row above</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare with Previous</td>
<td>Variance, Ratio, Sum</td>
</tr>
<tr>
<td>Use Periods</td>
<td>Display explicit dates in Scorecard portlet</td>
</tr>
<tr>
<td>Comparison Types</td>
<td>Define a number for the average</td>
</tr>
<tr>
<td>Show Date Row</td>
<td>Must have accounting periods set up and period filter in the saved search</td>
</tr>
</tbody>
</table>

Need More Information

NetSuite Help Center
SuiteAnalytics (Dashboards, Searches, & Reports) > Dashboards > Key Performance Indicators Overview > Trend Graphs
SuiteAnalytics (Dashboards, Searches, & Reports) > Dashboards > KPI Scorecards Overview
NetSuite for iPhone

SuiteAnswers
Search for answers to your questions
Go to Training Videos and access the Saved Searches/Reports category for the following training videos:
- Key Performance Indicators: Putting Trend Graphs on Multiple Dashboards

Now It’s Your Turn

For hands-on practice, you will:
- 01 - Display a Custom KPI as a Trend Graph
- 02 - Use Standard KPIs to Create a KPI Scorecard
- 03 - Compare Multiple KPIs in a Scorecard
Hands-on Exercises
Set Up Trend Graphs & Scorecards
Suggested Time to Complete Exercises: 10 - 15 minutes

01: Display a Custom KPI as a Trend Graph

Scenario
In this exercise, you display the data from the KPI: New Leads – Larry Nelson (from Exercise 10-02) as a trend graph.

The sales reps need to see a graph of their New Leads data.

Add the Trend Graph Portlet to the Home Dashboard

1. Click the Personalize Dashboard link on the Home Dashboard page.

2. Select Trend Graphs. Click the plus (+) sign next to one of the Trend Graphs.


Select the KPI to Display

4. Click the Setup link in the Trend Graph portlet.

5. Scroll to the bottom of the Trend Graphs list and select Custom KPI #1.


Change the Color of the Trend Graph

7. Enter #ff00ff, which is a bright pink, in the Custom Series Color field.

8. Click Save when you are done. Move the trend graph to a narrow portlet for a better display of the data.

NOTE: Know issues using IE browsers have been reported, however, no issues are reported using Chrome.
02: Use Standard KPIs to Create a KPI Scorecard

Scenario
In this exercise, you define a KPI scorecard using standard KPIs.

- To help detect trends in the business, the sales director wants to be able to easily track sales and profit performance over longer periods.
- They want to track the number of new leads, the number of opportunities in the pipeline, the number of new customers acquired, and the overall profit of the business.

Add the KPI Scorecard Portlet to the Home Dashboard

1. Click the Personalize Dashboard link in the top right-hand corner of the Home Dashboard.
2. Select the KPI Scorecard portlet in the Standard Content pane. The portlet is added to your dashboard on the right.
   
   *Note:* If the KPI Scorecard is already checked, this means the portlet is already added and named ‘Global Financial Ratios’ on the homepage. You will modify this KPI Scorecard portlet, in future steps.
3. Close the Personalize Content pane.

Define a New KPI Scorecard

4. Navigate to Customization tab > Centers and Tabs > KPI Scorecards > New.
5. Enter **KPI: Sales Dir. SC** as the name of the KPI Scorecard.

Add Standard KPIs and Define the Date Ranges

6. Add the following standard KPIs:
   - New Customers
   - New Leads
   - New Business
   - Open Opportunities
   - Profit
7. Click the Date Ranges tab and add the following date ranges:
   - this fiscal year
   - last fiscal year
   - the fiscal year before last
   - three fiscal years ago
8. Click Save when you are done.
Set Up the KPI Scorecard Portlet

9. Return to the Home Dashboard, locate the KPI Scorecard (see note) portlet. Click the down-down arrow and select Setup.

   *Note:* Remember, the KPI Scorecard portlet may already be named 'Global Financial Ratios'. If so, you will be changing this scorecard.

10. Select the KPI:Sales Dir. SC from the KPI Scorecard dropdown list.

11. Check the Show Trend Graph Icon box.

12. Check the Show Date Row box.

13. Click Save when you are done.

03: Compare Multiple KPIs in a KPI Scorecard

<table>
<thead>
<tr>
<th>Scenario</th>
<th>In this exercise, you define a KPI scorecard that includes comparisons of multiple KPIs. To help manage to quota, the sales managers need to compare:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Number of new leads identified</td>
</tr>
<tr>
<td></td>
<td>• Number of new customers acquired</td>
</tr>
<tr>
<td></td>
<td>• Company’s sales performance against the sales quota.</td>
</tr>
<tr>
<td></td>
<td>• They would also like to know how far they are from achieving quota.</td>
</tr>
</tbody>
</table>

Define a New KPI Scorecard

1. Navigate to Customization tab > Centers and Tabs > KPI Scorecards > New.

2. Enter Sales vs. Quota Scorecard as the name of the KPI scorecard.
Define a New KPI Scorecard

3. Add the following standard KPIs:

<table>
<thead>
<tr>
<th>KPI</th>
<th>Compare Value to</th>
<th>Comparison Type</th>
<th>Invert Comparison</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Leads</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Customers</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Leads</td>
<td>New Customers</td>
<td>Ratio (Percent)</td>
<td>Yes</td>
<td>Lead Conversion</td>
</tr>
<tr>
<td>Sales</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quota</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sales</td>
<td>Quota</td>
<td>Ratio (Percent)</td>
<td></td>
<td>% of Quota Achieved</td>
</tr>
<tr>
<td>Quota</td>
<td>Sales</td>
<td>Variance (Absolute)</td>
<td></td>
<td>Sales Needed to Hit Quota</td>
</tr>
</tbody>
</table>
4. Click the **Date Ranges** tab and add the following:

<table>
<thead>
<tr>
<th>Range</th>
<th>Compare Value to</th>
<th>Comparison Type</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>this month</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>last month</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>this fiscal year</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>last fiscal year</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>last rolling year</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>last fiscal year</td>
<td>last rolling year</td>
<td>Variance(Absolute)</td>
<td>Last FY to RY</td>
</tr>
<tr>
<td>fiscal year before last</td>
<td></td>
<td></td>
<td>2 Fiscal Years Ago</td>
</tr>
<tr>
<td>three fiscal years ago</td>
<td></td>
<td></td>
<td>3 Fiscal Years Ago</td>
</tr>
<tr>
<td>fiscal year before last</td>
<td>three fiscal years ago</td>
<td>Variance(Absolute)</td>
<td>2 to 3 Fiscal years Ago</td>
</tr>
</tbody>
</table>

5. Click **Save** when you are done.

**Set Up the KPI Scorecard Portlet**

6. Return to the **Home Dashboard** and click the **Setup** link in the **KPI Scorecard** portlet.

7. Select the **Sales vs. Quota Scorecard** from the KPI Scorecard dropdown list.

8. Select **All** from the **Restrict To** dropdown list.

9. Select **Date Ranges on Left** from the **Orientation** dropdown list.

10. Check the **Trend Graph Icon** box, if necessary.

11. Click **Save** when you are done.
12: Realizing Smart Dashboards

Introduction
Now that I know how to effectively mine my data for key intelligence, how do I assemble all these various components into a “smart” dashboard?

- Leverage reports, saved searches, and custom metrics for insight
- Expose trend graphs in dedicated portlets

About this Module
In this module, we examine how to create smart dashboards by using all of the SuiteAnalytics components and employing best practices for design and layout.

- Study best practices and considerations for personalizing the Home Dashboard
- Define the key steps for publishing dashboards to specific users

Objectives:
Upon completing this module, you should be able to:

- Personalize Home dashboards
- Identify who can publish dashboards and to which Centers
- Explain the key steps for publishing dashboards
- Describe ongoing dashboard maintenance considerations and re-publishing steps
Smart Dashboards

A smart dashboard needs to display relevant and real-time data, leveraging off of the various SuiteAnalytics solutions:
- Reports: Snapshots, KPIs, KPI meters
- Saved Searches: Custom search portlets, Custom KPIs, Custom KPI meters
- KPI Scorecard built with standard and custom KPIs

Personalize Your Home Dashboard

Add SuiteAnalytics
Click Personalize Page on the Home Dashboard to open the Add Content panel

Select Standard Content:
- Support Business Process Flow
- Provide analysis

Add Report Snapshots (10 allowed)
Choose a maximum of 5 Trend Graphs
List portlet may display a saved search
Shortcut links to frequently used reports and saved searches
Quick Date Selector works with important dashboard content, such as: KPIs, Report Snapshots, and KPI Scorecard

Define the dashboard layout
Use the Home Dashboard space logically, considering vertical and horizontal placement of the content, such as:
- Report Snapshots
- KPIS and KPI Scorecard
- KPI meters
- Trend Graphs

Requirements for Publishing Dashboards

Must have the Publish Dashboards permission
A Publish Dashboard link displays in the Settings portlet on your Home page, if the role has the permission
You can customize a role, name it PUB: rolename, and assign to yourself
Or use Global Permissions and give yourself/the person responsible Publish Dashboards as a Global Permission
Must be in a role with the same Center type for which you are creating the custom dashboard
To identify the Center Type for a role go to: Setup > Users/Roles > Manage Roles
Roles and Permissions for Publishing

If *not* using Global Permissions or custom roles, the following standard roles allow publishing dashboards:

<table>
<thead>
<tr>
<th>Roles</th>
<th>Standard Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Can publish dashboards to the Full Access role in the Classic Center.</td>
</tr>
<tr>
<td>Marketing Administrator</td>
<td>Can publish dashboards to users assigned roles in the Marketing Center.</td>
</tr>
<tr>
<td>Sales Administrator</td>
<td>Can publish dashboards to users assigned roles in the Sales Center.</td>
</tr>
<tr>
<td>Support Administrator</td>
<td>Can publish dashboards to users assigned roles in the Support Center.</td>
</tr>
<tr>
<td>System Administrator</td>
<td>Can publish dashboards to users assigned roles in the System Administrator Center.</td>
</tr>
</tbody>
</table>

Publishing Dashboards

**Create and assign the customized role**

Use the Administrator role to create customized roles with the Publish Dashboards permission:

- Create a copy of the role
- Add publish to the name of the role
- Add the Publish Dashboard permission and save
- Assign yourself the role
- Click the **Change Role** link and switch to that role

*Note: do not use the Administrator role to publish dashboards*

**Assign the Publish Dashboard global permission**

Enable the Global Permissions feature, then in your employee record assign Publish Dashboards as a Global Permission.

Next, assign yourself a role either the role for which you want to publish the dashboard or a role belonging to the same Center

*Example: to publish a Dashboard to the AR Clerk, give yourself either the AR Clerk role or another Accounting role – Accountant, Bookkeeper, etc*
Customize the dashboard layout and content
Swap to the role you have assigned yourself. Add the portlets and set the layout for the dashboard:

- Click the Personalize link on the Home Dashboard and any tabbed pages you want to customize
- Add, remove, and arrange portlets as necessary for each dashboard

Select the dashboard roles and setting
The dashboard can now be published!

- Go to Settings portlet and click the Publish Dashboard link
- Enter a name for the dashboard
- Select the role to which you want to publish the dashboard
- Choose to publish the dashboard to new users or to both new and existing users

Select the settings to apply to the dashboard:

- **Lock Shortcuts**: Allows users to add and reorder links in their Shortcuts portlets, but they cannot remove them
- **Lock New Bar**: Allows users to add and reorder links in the Create New bars, but they cannot remove the Create New bar links on the published dashboard pages
- **Override existing user’s settings**: Overrides the current dashboard for the role and replaces it with the new dashboard

Select the tabbed page where the dashboard will be published
Select the tabs to where the dashboard will be published:

- Select the tabbed pages that you want to publish the dashboard to
- Select the appropriate restriction mode for each tabbed page
- Save the dashboard
- Test and edit as necessary

Set the dashboard restriction modes
Set the level of control users will have on the dashboards:

- **Unlocked**: Allows users to add, move and remove content from the dashboard layout
  - Requires the least amount of work for the Administrator because employees can make any change as needed
- **Add/Move Content**: Allows users to add or move content to the dashboard, but not remove it
  - Requires less work from the Administrator because employees have some control of their dashboards
- **Locked**: Prevents users from making any changes to the dashboards
  - Requires the most work for the Administrator because dashboard changes can only be made by the Administrator
Maintain Dashboards

Manage published dashboards
Regularly evaluate published dashboards; ensuring relevance.

Dashboards should be updated as:

- Corporate and department goals change; user roles and requirements change
- NetSuite data changes; features are added and changed
- NetSuite features are added and change

There’s never a bad time to create a good dashboard!

Change published dashboards
If you need to change your published dashboards, create a new dashboard and re-publish to the roles:

- Log in with the role you used to create the dashboard and make changes to one or more tabbed pages
- Go to your Home page and click the List link next to Publish Dashboard in the Settings portlet
- Click Edit next to the dashboard you have just changed
- Change the dashboard roles and settings:
  - Add or remove roles as necessary
  - Check Override existing user’s settings box for each role that you are applying the changed dashboard to
- Click the Save and Update Content button:
  - Click the Cancel button on the Save and Update dialogue box to change the applied tabs and mode restrictions

Activity: Match Game

Can you publish to a new tabbed page after you have published a dashboard?
If you have the Publish Dashboards permission, where can you publish dashboards?
Which dashboard restriction mode requires the most work for the Administrator?
True or False: You must be in a role with the same Center type for which you are creating the custom dashboard.
What happens when the Override existing user’s settings is checked?
Need More Information

NetSuite Help Center
SuiteAnalytics (Dashboards, Searches, & Reports) > Dashboards > Publishing
Dashboards Overview

SuiteAnswers
Search for answers to your questions
Go to Training Videos and access the Saved Searches/Reports category for the following training videos:
- Dashboards: Defining User Requirements
- Dashboards: Designing Role-Specific Dashboards
- Dashboards: Publishing Dashboards

Now It’s Your Turn

For hands-on practice, you will:

01 - Enable Global Permissions and Assign Sales Role
02 - Design the Home Dashboard
03 - Design the Opportunities Dashboard
04 - Publish the Dashboards
Hands-on Exercises
Realize Smart Dashboards
Suggested Time to Complete Exercises: 20 -30 minutes

01: Define Publish Permissions

Scenario
You have been asked by the Sales Manager to publish a Home Dashboard to their team of Sales Reps; the Sales Manager and you have discussed the content to be added and the layout of the portlets

- Every sales rep needs to have the same dashboard, with limited ability to modify it.

In this exercise, you:

- Enable the Global Permissions feature
- Grant yourself the Global Permission to Publish Dashboards
- Assign yourself a Sales Role

Customize Sales Manager Role

1. Go to Setup > Users/Roles > Manage Roles
2. Click Edit next to the Sales Rep - Basic role.
3. In the Name field enter PUB: Sales Rep – Basic.
4. Go to the Permissions subtab and the Setup sublist.
5. Add the Publish Dashboards permission.
6. Click Save As to save this new role.

Assign the ‘Publishing’ role to Larry Nelson

7. Go to Lists > Employees > Employees.
8. Click the Edit link next Larry Nelson.
9. Go to Access subtab.

Assign the Basic Sales Role

10. Select the Sales Rep - Basic role and click Add. Note: You need to add the Sales Rep role so you can validate the changes to the dashboards later.
11. Click Save to save your changes to your employee record.
02: Design the Home Dashboard

Scenario
You have added the Sales Rep role with the Publish Dashboards permission to your employee record. Now you need to sign in as that role to and customize the Home Dashboard.

Change Your Role
1. Click the Change Role link and switch to the PUB Sales Rep – Basic role.

Add and Arrange the Portlets
2. Click the Personalize Dashboard link on the Home Dashboard to add the following portlets to the dashboard:

<table>
<thead>
<tr>
<th>Activities</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar</td>
<td>Reminders</td>
</tr>
<tr>
<td>Custom Search</td>
<td>Settings</td>
</tr>
<tr>
<td>Phone Calls</td>
<td>Shortcuts</td>
</tr>
</tbody>
</table>

Close the Personalize Dashboard pane when you are done.
3. Organize the dashboard, by dragging and dropping the portlets.

   Remember the design considerations for different employee roles and be sure to remove the New Release portlet.

4. Click the Set Up link in the Custom Search portlet and select Prospects to Contact (from Exercise 06 -01). Click Save.

Change the Create New Bar
5. From the Create New icon toolbar at the top of the page, click >> and select Personalize.

   Note: Personalize, may be presented as a link on the toolbar.

6. Check Event, Phone Call, Lead, and Quote, only. Uncheck the other links.

7. Click the Save button.

Suggested Layout: Reminders should be the top-left portlet, with Calendar Activities, Calendar and Settings portlets underneath. The center column should include the Custom Search, Phone Calls, Tasks and Shortcuts portlets.

Remember: Dashboards should not be too busy or overloaded with information.
03: Design the Opportunities Dashboard

Scenario: You also need to customize the dashboard for the Leads tabbed page.

1. Click the Opportunities tab.
2. Click the Personalize Dashboard link.
3. Add the following portlets to the dashboard:
   - Custom Search
     - Report Snapshots: Select the following Snapshot Types:
       - Forecast by Status
       - Open Quotes

   Note: You might need to change the date ranges to view data.

   Close the Personalize Dashboard window when you are finished.

4. Remove the following portlets from the dashboard: Select Remove under the portlet setup icon.
   - Quick Add: New Opportunity
   - Quick Search
   - Recent Records

5. Organize the dashboard layout by dragging and dropping the portlets.
6. Click Set Up in the Report Snapshot: Top 5 Open Quotes portlet. Change the Display Type to List and click Save.
7. Click Set Up in the Custom Search portlet and select the My Opportunities to Close search. (If there are two displayed in the list, select the second one in the list).
   Click Save when you are done.
8. Review and change, if necessary, personalize the Create New bar to include additional sales-related ‘create new icons’. For Example: you would add Prospects, Quotes, Saved Searches etc. (Click >> Personalize to modify the tool bar.)

   **Suggested Layout:** The Report Snapshots should be in the top-left corner. The center column should include the Custom Search and Opportunities portlets.
04: Publish the Dashboards

Scenario

Once you have the look and content of the dashboards to your satisfaction, you need to publish these layouts to the appropriate users.

Select the Dashboard Roles and Settings

1. Click the Home tab and go to Settings portlet. Note: you may need to expand the Settings portlet by clicking on the + button.
2. Click the Publish Dashboard link.
3. Type in the Name of the dashboard: Sales Rep - Basic Dashboards. Tip: You should consider creating a consistent naming convention.
4. Add Notes that provide information about this dashboard, to distinguish this from other dashboards that you might create.
5. Check the Lock Shortcuts checkbox. This will prevent users from removing or changing the shortcuts provided.
6. Check the Lock New Bar checkbox. This will prevent users from removing or changing the links on the bar.
7. Go to Apply to Roles tab and select the Sales Rep – US West role. Additionally, indicate Yes to Override existing user’s settings.
8. Click Add. DO NOT FORGET: If you do not click Add, the Dashboard will not be published to this role.

Select the Tabbed Pages and Restriction Modes

9. Go to the Apply to Tabs subtab and check the Apply Checkbox next to the following tabs and make the following restriction settings:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>Add/Move Content</td>
</tr>
<tr>
<td>Leads</td>
<td>Unlocked</td>
</tr>
<tr>
<td>Opportunities</td>
<td>Locked</td>
</tr>
</tbody>
</table>

These are the tabs to which we are going to publish the dashboard.
10. Click Save and your Dashboards will be published.
**Test the Published Dashboard**

11. Now we need to test our published dashboard.
   
   Log out of the system and log back in. This time go to the **Sales Rep – US West** role to see the newly published dashboard.
   
   **Warning:** Due to browser caching, you may need to do a hard refresh (**Ctrl + F5**) to refresh the browser and see the changes.

12. Verify that your dashboard was published. Remember that because of the Global Permissions setting you will still see the Publish Dashboards link in your Settings portlet; other users with this same role without this Global Permission will not see this link.
13: Wrap Up

Introduction
Whew! We’ve done it! We completed this course and its exercises.

About this Module
Now, it’s time to...
  - Look back at the course objectives and your expectations
  - Review best practices
  - Answer any remaining questions
Course Objectives

During the last two days we learned how to:

- Use standard reports for point-in-time analysis
- Customize standard reports to match business requirements
- Tap into standard metrics, such as KPIs, to help monitor business trends
- Create searches to access and dynamically display key data
- Define custom KPIs and display them in the KPI portlet and as KPI Meters
- Create a personalized, real-time dashboard rich with tools to analyze my operational performance

Keys to Success

To take full advantage of SuiteAnalytics, remember to:

- Leverage standard NetSuite capabilities first
- Design and plan before you start customizing reports or creating saved searches
- Keep the end in mind; what are you trying to get to?
- Modify and create new only when necessary
- Map tasks to SuiteAnalytics solution categories: data management, analysis and distribution
- Realize your smart dashboard through the use of SuiteAnalytics

SuiteTraining

Interested in learning about all SuiteTraining courses available?

- Visit the NetSuite Training Catalog page at: [http://www.netsuite.com/portal/services/training/catalog.shtml](http://www.netsuite.com/portal/services/training/catalog.shtml)

Training Is the Most Critical Factor

Why should you develop a training plan?

- Untrained users cost five times more to support than trained users*
- Two-thirds of enterprises will pay informal training costs (out of the support budget) that are at least 20 times higher than would have been required for up-front formal training.*
- 70% of companies cite the most critical factor for new software implementation success and ROI is effective training and user adoption*
- Contact training@netsuite.com
- *Source: Gartner Research Publications: Business Intelligence Applications Benefit From Interactive Visualization; To Train or Not to Train Remote Users: Is There a Question?; Intersection of IT Support and End-User Training; Untrained Users Cost More to Support than Trained Users
NetSuite Certification

NetSuite Certification Program is available:

- Become certified in NetSuite and contribute to your organization’s success
- Complete and pass required exams:
  - Certification fees may be applicable for each exam
- **Please refer to the Certification Program page:**
  [http://www.netsuite.com/portal/services/training/certification.shtml](http://www.netsuite.com/portal/services/training/certification.shtml) for more information

We Value Your Feedback

One more thing!

Please navigate to the address listed below and fill in the Course Evaluation if you haven’t already:  [http://psu.netsuite.com/admin](http://psu.netsuite.com/admin)
You have reached
of the topics and exercises
Appendices, with optional material, follows
Workbook Appendices

Requirements and Design Worksheets

SuiteAnalytics Task Matrix

This matrix illustrates the data management, data analysis and data distribution tasks supported by SuiteAnalytics.

This matrix does not represent a complete list of all the SuiteAnalytics capabilities, but it should help you identify which solution meets your needs.

<table>
<thead>
<tr>
<th>Data Management Tasks</th>
<th>Report</th>
<th>Saved Search</th>
<th>KPI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create lists of records to focus employees on critical information</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Highlight specific records based on specific conditions</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Update records in a list (using Direct List Editing)</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Create groups of employees, customers, partners and vendors</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Create custom forms to facilitate searches for specific records</td>
<td></td>
<td></td>
<td>x</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data Analysis Tasks</th>
<th>Report</th>
<th>Saved Search</th>
<th>KPI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drill down into output for details</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Use predefined filters to refine the data output results</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Customize output/format into groups, subtotals and totals</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apply formulas to report metrics and saved search criteria</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Create graphs and charts to display data visually</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>
**SuiteAnalytics Task Matrix** Continued

This matrix does not represent a complete list of all the SuiteAnalytics capabilities, but it should help you identify which solution meets your needs.

<table>
<thead>
<tr>
<th>Data Analysis Tasks Continued</th>
<th>Report</th>
<th>Saved Search</th>
<th>KPI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add report snapshots of data output to dashboards</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Compare metrics over multiple date ranges (or periods)</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Create complex comparisons of multiple metrics over multiple date ranges (or periods)</td>
<td></td>
<td></td>
<td>x</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data Distribution Tasks</th>
<th>Report</th>
<th>Saved Search</th>
<th>KPI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow direct access to specific users/roles</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Publish results on dashboards</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Export output to Word, PDF</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export to CSV, Excel</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Provide access to real-time data without a NetSuite login (Excel Web Query)</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Send output through emails (on demand or scheduled)*</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email output to non-NetSuite users</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email alerts upon changes of values or addition of data*</td>
<td></td>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>

*To learn about scheduled emails and email alerts peruse the Training Videos from the Reports and Searches section in SuiteAnswers.
### Requirements and Design Worksheets

**SuiteAnalytics Requirements Worksheet**

Before you create your analysis, it is important to identify the user and data requirements. Determining what the user needs to do - in terms of data management, data analysis or data distribution - dictates what you need to create. Answer the questions in this worksheet to identify what SuiteAnalytics solution is needed and to obtain the information you need for creating the corresponding report or saved search.

Depending on the complexity of the analysis to be created, you might not need to answer all of these questions. Use the Design Worksheet template, on the next tab, to design the layout of the needed analysis and to identify if a standard NetSuite report or KPI meets your needs.

Use a separate Requirements Worksheet for each report, saved search or KPI to be created.

#### Data Management

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who needs to use the data?</td>
<td>Sales Reps and Sales Managers</td>
</tr>
<tr>
<td>How is the data to be used?</td>
<td>Review to determine movement of various products</td>
</tr>
<tr>
<td>What kind of data is needed?</td>
<td>Sales Information</td>
</tr>
<tr>
<td>What is the primary record type that is needed?</td>
<td>Item Type</td>
</tr>
<tr>
<td>Does the data need to be grouped or totalled?</td>
<td>Yes, needs to be grouped by sales rep and by product</td>
</tr>
<tr>
<td>Does the data need to be highlighted?</td>
<td>No</td>
</tr>
<tr>
<td>Does the user need to be able to perform direct list editing of the results?</td>
<td>No</td>
</tr>
<tr>
<td>Do the results need to be published on a dashboard?</td>
<td>Yes</td>
</tr>
<tr>
<td>Does the output need to be a list of employees, customers, partners, or vendors that can be used for groups?</td>
<td>No</td>
</tr>
</tbody>
</table>
**Sample SuiteAnalytics Requirements and Design Worksheet**

<table>
<thead>
<tr>
<th>Data Analysis</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Are any calculations required?</td>
<td>No</td>
</tr>
<tr>
<td>Are any formulas required?</td>
<td>Yes</td>
</tr>
<tr>
<td>Are third-party report writing tools needed for additional grouping, data manipulation, and formatting?</td>
<td>No</td>
</tr>
<tr>
<td>Does the data need to be presented in a trend graph?</td>
<td>Yes</td>
</tr>
<tr>
<td>Complex comparisons of multiple metrics over multiple date ranges/periods needed?</td>
<td>No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data Distribution</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Does the data need to be sent to other users?</td>
<td>Yes</td>
</tr>
<tr>
<td>Who is the recipient of the data?</td>
<td>Regional Sales Manager</td>
</tr>
<tr>
<td>Is the recipient a user outside of the NetSuite account?</td>
<td>No</td>
</tr>
<tr>
<td>How often does the data need to be sent/received?</td>
<td>Weekly</td>
</tr>
<tr>
<td>Does the recipient need to be alerted when changes are made to the data?</td>
<td>No</td>
</tr>
<tr>
<td>Does the data need to be published to a dashboard?</td>
<td>Yes</td>
</tr>
<tr>
<td>Does the data output need to be exported to Word or PDF?</td>
<td>No</td>
</tr>
<tr>
<td>Does the data output need to be exported to CSV or Excel?</td>
<td>No</td>
</tr>
</tbody>
</table>
Before you create the needed analysis, design the layout of the report, saved search or KPI. Then determine if a standard NetSuite report or KPI meets your needs. You might be able to modify a standard report or KPI rather than create a new one.

Use a separate Design Worksheet for each report, saved search or KPI to be created.

**Data Results Layout**

What does the data output of the analysis need to look like?

<table>
<thead>
<tr>
<th>Title</th>
<th>Sales Rep Report by Product</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Column Heading</td>
</tr>
<tr>
<td></td>
<td>Sales Rep</td>
</tr>
<tr>
<td>Row Name</td>
<td>Sales grouped by item by Sales Rep</td>
</tr>
<tr>
<td>Row Name</td>
<td></td>
</tr>
<tr>
<td>Row Name</td>
<td></td>
</tr>
<tr>
<td>Row Name</td>
<td></td>
</tr>
</tbody>
</table>
Sample SuiteAnalytics Requirements and Design Worksheet

<table>
<thead>
<tr>
<th>Standard NetSuite Reports or KPIs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is there a NetSuite standard report or KPI that is similar?</td>
</tr>
</tbody>
</table>

What does the NetSuite report or KPI look like?

<table>
<thead>
<tr>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>Item Disc.</td>
<td>Qty. Sold</td>
<td>Total Revenue</td>
<td></td>
</tr>
<tr>
<td>Row Name</td>
<td>Item A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row Name</td>
<td>Item B</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row Name</td>
<td>Item C</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row Name</td>
<td>Item D</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Gap Analysis

What is missing from the NetSuite report or KPI?

Need to add a column to include the Sales Reps
Before you create your analysis, it is important to identify the user and data requirements. Determining what the user needs to do - in terms of data management, data analysis or data distribution - dictates what you need to create. Answer the questions in this worksheet to identify what SuiteAnalytics solution is needed and to obtain the information you need for creating the corresponding report or saved search.

Depending on the complexity of the analysis to be created, you might not need to answer all of these questions. Use the Design Worksheet template, on the next tab, to design the layout of the needed analysis and to identify if a standard NetSuite report or KPI meets your needs.

Use a separate Requirements Worksheet for each report, saved search or KPI to be created.

<table>
<thead>
<tr>
<th>Data Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who needs to use the data?</td>
</tr>
<tr>
<td>How is the data to be used?</td>
</tr>
<tr>
<td>What kind of data is needed?</td>
</tr>
<tr>
<td>What is the primary record type that is needed?</td>
</tr>
<tr>
<td>Does the data need to be grouped or totalled?</td>
</tr>
<tr>
<td>Does the data need to be highlighted?</td>
</tr>
<tr>
<td>Does the user need to be able to perform direct list editing of the results?</td>
</tr>
<tr>
<td><strong>Do the results need to be published on a dashboard?</strong></td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td><strong>Does the output need to be a list of employees, customers, partners, or vendors that can be used for groups?</strong></td>
</tr>
<tr>
<td><strong>Data Analysis</strong></td>
</tr>
<tr>
<td>Are any calculations required?</td>
</tr>
<tr>
<td>Are any formulas required?</td>
</tr>
<tr>
<td>Are third-party report writing tools needed for additional grouping, data manipulation, and formatting?</td>
</tr>
<tr>
<td>Does the data need to be presented in a trend graph?</td>
</tr>
<tr>
<td>Complex comparisons of multiple metrics over multiple date ranges/periods needed?</td>
</tr>
<tr>
<td><strong>Data Distribution</strong></td>
</tr>
<tr>
<td>Does the data need to be sent to other users?</td>
</tr>
<tr>
<td>Who is the recipient of the data?</td>
</tr>
<tr>
<td>Is the recipient a user outside of the NetSuite account?</td>
</tr>
<tr>
<td>How often does the data need to be sent/received?</td>
</tr>
<tr>
<td>Does the recipient need to be alerted when changes are made to the data?</td>
</tr>
<tr>
<td>Does the data need to be published to a dashboard?</td>
</tr>
<tr>
<td>Does the data output need to be exported to Word or PDF?</td>
</tr>
<tr>
<td>Does the data output need to be exported to CSV or Excel?</td>
</tr>
</tbody>
</table>

© NetSuite Inc.  Duplication is prohibited  156
Before you create the needed analysis, design the layout of the report, saved search or KPI. Then determine if a standard NetSuite report or KPI meets your needs. You might be able to modify a standard report or KPI rather than create a new one.

Use a separate Design Worksheet for each report, saved search or KPI to be created.

### Data Results Layout

What does the data output of the analysis need to look like?

<table>
<thead>
<tr>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Heading</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>Row Name</td>
</tr>
<tr>
<td>Row Name</td>
</tr>
<tr>
<td>Row Name</td>
</tr>
<tr>
<td>Row Name</td>
</tr>
<tr>
<td>Row Name</td>
</tr>
</tbody>
</table>
### Standard NetSuite Reports or KPIs

<table>
<thead>
<tr>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Gap Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is missing from the NetSuite report or KPI?</td>
</tr>
</tbody>
</table>
Before you create your analysis, it is important to identify the user and data requirements. Determining what the user needs to do - in terms of data management, data analysis or data distribution - dictates what you need to create. Answer the questions in this worksheet to identify what SuiteAnalytics solution is needed and to obtain the information you need for creating the corresponding report or saved search.

Depending on the complexity of the analysis to be created, you might not need to answer all of these questions. Use the Design Worksheet template, on the next tab, to design the layout of the needed analysis and to identify if a standard NetSuite report or KPI meets your needs.

Use a separate Requirements Worksheet for each report, saved search or KPI to be created.

### Data Management

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who needs to use the data?</td>
<td></td>
</tr>
<tr>
<td>How is the data to be used?</td>
<td></td>
</tr>
<tr>
<td>What kind of data is needed?</td>
<td></td>
</tr>
<tr>
<td>What is the primary record type that is needed?</td>
<td></td>
</tr>
<tr>
<td>Does the data need to be grouped or totalled?</td>
<td></td>
</tr>
<tr>
<td>Does the data need to be highlighted?</td>
<td></td>
</tr>
<tr>
<td>Does the user need to be able to perform direct list editing of the results?</td>
<td></td>
</tr>
<tr>
<td>Do the results need to be published on a dashboard?</td>
<td></td>
</tr>
<tr>
<td>Does the output need to be a list of employees, customers, partners, or vendors that can be used for groups?</td>
<td></td>
</tr>
</tbody>
</table>
# Data Analysis

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Are any calculations required?</td>
<td></td>
</tr>
<tr>
<td>Are any formulas required?</td>
<td></td>
</tr>
<tr>
<td>Are third-party report writing tools needed for additional grouping, data manipulation, and formatting?</td>
<td></td>
</tr>
<tr>
<td>Does the data need to be presented in a trend graph?</td>
<td></td>
</tr>
<tr>
<td>Complex comparisons of multiple metrics over multiple date ranges/periods needed?</td>
<td></td>
</tr>
</tbody>
</table>

# Data Distribution

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Does the data need to be sent to other users?</td>
<td></td>
</tr>
<tr>
<td>Who is the recipient of the data?</td>
<td></td>
</tr>
<tr>
<td>Is the recipient a user outside of the NetSuite account?</td>
<td></td>
</tr>
<tr>
<td>How often does the data need to be sent/received?</td>
<td></td>
</tr>
<tr>
<td>Does the recipient need to be alerted when changes are made to the data?</td>
<td></td>
</tr>
<tr>
<td>Does the data need to be published to a dashboard?</td>
<td></td>
</tr>
<tr>
<td>Does the data output need to be exported to Word or PDF?</td>
<td></td>
</tr>
<tr>
<td>Does the data output need to be exported to CSV or Excel?</td>
<td></td>
</tr>
</tbody>
</table>
Before you create the needed analysis, design the layout of the report, saved search or KPI. Then determine if a standard NetSuite report or KPI meets your needs. You might be able to modify a standard report or KPI rather than create a new one.

Use a separate Design Worksheet for each report, saved search or KPI to be created.

Data Results Layout

What does the data output of the analysis need to look like?

<table>
<thead>
<tr>
<th>Title</th>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Standard NetSuite Reports or KPIs

<table>
<thead>
<tr>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
<th>Column Heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Gap Analysis

What is missing from the NetSuite report or KPI?